Oracle Financials Cloud
Using Financials for the Americas

19C
# Contents

**Preface**

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Preface</td>
<td>i</td>
</tr>
</tbody>
</table>

## 1 Financials for Mexico

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>General Ledger Reporting</td>
<td>1</td>
</tr>
<tr>
<td>FAQs for General Ledger Reporting</td>
<td>30</td>
</tr>
</tbody>
</table>

## 2 Financials for Brazil

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fiscal Document Generation</td>
<td>33</td>
</tr>
<tr>
<td>Fiscal Document Capture</td>
<td>38</td>
</tr>
<tr>
<td>Transaction Taxes</td>
<td>42</td>
</tr>
<tr>
<td>Receivables</td>
<td>48</td>
</tr>
<tr>
<td>Payables</td>
<td>55</td>
</tr>
</tbody>
</table>

## 3 How To Topics

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overview of Configuring Fiscal Document for Brazil</td>
<td>61</td>
</tr>
<tr>
<td>Overview of Configuring Tax Registrations for Brazil</td>
<td>61</td>
</tr>
<tr>
<td>Overview of Managing Fiscal Documents Approvals Through a Third Party</td>
<td>62</td>
</tr>
<tr>
<td>Overview of Managing General Fiscal Documents</td>
<td>62</td>
</tr>
<tr>
<td>Overview of Managing Fiscal Documents for Manual Receivables Invoices</td>
<td>63</td>
</tr>
<tr>
<td>Overview of Managing Fiscal Documents for Imported Receivables Invoices</td>
<td>63</td>
</tr>
<tr>
<td>Overview of Managing Fiscal Document Variations</td>
<td>64</td>
</tr>
<tr>
<td>Overview of Managing Transaction Taxes for Brazil</td>
<td>64</td>
</tr>
<tr>
<td>Overview of Managing Withholding Taxes for Brazil</td>
<td>65</td>
</tr>
<tr>
<td>Overview of Managing Fiscal Documents for Internal Material Transfers</td>
<td>65</td>
</tr>
<tr>
<td>Overview of Managing Fiscal Documents for Returns to Supplier</td>
<td>66</td>
</tr>
<tr>
<td>Overview of Creating Fiscal Documents for Fixed Asset Transfers</td>
<td>66</td>
</tr>
<tr>
<td>Overview of Managing Fiscal Documents for Miscellaneous Purposes</td>
<td>66</td>
</tr>
<tr>
<td>Overview of Managing Complementary Fiscal Documents for Brazil</td>
<td>67</td>
</tr>
<tr>
<td>Overview of Capturing Fiscal Documents of Purchase Orders</td>
<td>67</td>
</tr>
<tr>
<td>Overview of Entering Fiscal Documents in Payables</td>
<td>68</td>
</tr>
<tr>
<td>Overview of Managing Payables Collection Documents for Brazil</td>
<td>68</td>
</tr>
</tbody>
</table>
4 Financials Reports for the Americas

Purchase Withholding Certificate for Chile ................................. 69
Purchase Withholding Certificate for Argentina ......................... 69
Purchase Withholding Certificate for Colombia ......................... 70
Preface

This preface introduces information sources that can help you use the application.

Using Oracle Applications

Using Applications Help

Use help icons ? to access help in the application. If you don’t see any help icons on your page, click your user image or name in the global header and select Show Help Icons. Not all pages have help icons. You can also access Oracle Applications Help.

Watch: This video tutorial shows you how to find help and use help features.

You can also read Using Applications Help.

Additional Resources

- **Community:** Use Oracle Cloud Customer Connect to get information from experts at Oracle, the partner community, and other users.

- **Guides and Videos:** Go to the Oracle Help Center to find guides and videos.

- **Training:** Take courses on Oracle Cloud from Oracle University.

Conventions

The following table explains the text conventions used in this guide.

<table>
<thead>
<tr>
<th>Convention</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>boldface</strong></td>
<td>Boldface type indicates user interface elements, navigation paths, or values you enter or select.</td>
</tr>
<tr>
<td><strong>monospace</strong></td>
<td>Monospace type indicates file, folder, and directory names, code examples, commands, and URLs.</td>
</tr>
<tr>
<td>&gt;</td>
<td>Greater than symbol separates elements in a navigation path.</td>
</tr>
</tbody>
</table>

Documentation Accessibility

For information about Oracle’s commitment to accessibility, visit the Oracle Accessibility Program website.

Videos included in this guide are provided as a media alternative for text-based help topics also available in this guide.
Contacting Oracle

Access to Oracle Support
Oracle customers that have purchased support have access to electronic support through My Oracle Support. For information, visit My Oracle Support or visit Accessible Oracle Support if you are hearing impaired.

Comments and Suggestions
Please give us feedback about Oracle Applications Help and guides! You can send an e-mail to: oracle_fusion_applications_help_ww_grp@oracle.com.
1 Financials for Mexico

General Ledger Reporting

Enable the Mexican Reporting Processes

To run the Journals for Mexico and Chart of Accounts for Mexico reports, you must:

- Enable the processes to run them from the Scheduled Processes page in Oracle Fusion Applications.
- Provide users access to the processes.

Enable the Process

Enable the processes so that you can run them from the Scheduled Processes page in Oracle Fusion. Perform the following steps to enable the processes:

1. Sign in to the Oracle Authorization Policy Manager.
2. Select fscm from the Application Name section.
3. Click New in the Resources section.

An untitled page appears.

4. Enter the details given in the following table:

<table>
<thead>
<tr>
<th>Field</th>
<th>For Journals for Mexico</th>
<th>For Chart of Accounts for Mexico</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resource Type</td>
<td>ESSMetadataResourceType</td>
<td>ESSMetadataResourceType</td>
</tr>
<tr>
<td>Display Name</td>
<td>Journals for Mexico</td>
<td>Chart of Accounts for Mexico</td>
</tr>
<tr>
<td>Name</td>
<td>oracle.apps.ess.financials.tax.report.</td>
<td>oracle.apps.ess.financials.tax.report.</td>
</tr>
<tr>
<td></td>
<td>JobDefinition.MexicanChartOfAccBIPJob</td>
<td>JobDefinition.MexicanChartOfAccBIPJob</td>
</tr>
<tr>
<td>Description</td>
<td>Generates journals for Mexico electronic</td>
<td>Generates chart of accounts for Mexico electronic</td>
</tr>
<tr>
<td></td>
<td>accounting.</td>
<td>accounting.</td>
</tr>
</tbody>
</table>

5. Click Save.

You navigate to the Home page.

6. Verify if your resource is added successfully:
   
a. Click Search on the Home page.
   
The Search Resource page appears.
   
b. Select Resource Type as ESSMetadataResourceType.
   
c. Enter the Display Name as:
   
   - Journals for Mexico for the Journals for Mexico report.
• **Chart of Accounts for Mexico** for the Chart of Accounts for Mexico report.
  
  **d.** Click **Search**.
  
  Your resource is added correctly if it appears in the Search Results region.

7. Navigate back to the Home page.
8. Click **Search** in the Entitlements section.

The Search Entitlements page appears.

9. Enter **Run Tax Reporting** in the **Display Name** field.
10. Click **Search**.
11. Select the **Run Tax Reporting** row in the Search Results section and click **Open**.
12. Click **Add** to add a resource to this entitlement.

The **Add Targets** dialog box appears.

13. Enter the details as given in the following table:

<table>
<thead>
<tr>
<th>Field</th>
<th>For Journals for Mexico</th>
<th>For Chart of Accounts for Mexico</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resource Type</td>
<td>ESSMetadataResourceType</td>
<td>ESSMetadataResourceType</td>
</tr>
<tr>
<td>Display Name</td>
<td>Journals for Mexico</td>
<td>Chart of Accounts for Mexico</td>
</tr>
</tbody>
</table>

14. Click **Search**.
15. Select the **Journals for Mexico** row in the Search Results section and click **Add Selected**.
16. Click **Add Targets**.
17. Select the **Journals for Mexico** row in the Entitlement section and select the following check boxes:
  
  - **Update**
  - **Execute**
  - **Delete**
  - **Read**

18. Click **Apply**.

The Journal for Mexico process is enabled and can be accessed from the Scheduled Processes page in Oracle Fusion Applications.

19. Repeat steps 15 to 18 to add targets for the Chart of Accounts for Mexico process. Select Chart of Accounts for Mexico instead of Journals for Mexico while performing the steps.

**Proving Access to Users**

Perform the following steps in Oracle Identity Manager to provide users access to the Chart of Accounts for Mexico and Journals for Mexico processes:

1. Sign in to Oracle Identity Manager with IT_SECURITY_MANAGER.
2. Click **Administration**.
3. Search for the users to provide access. You can either:
  
  - Click **Users** in the **Search** list. This displays all the users.
  - Click the Advanced Search: Users tab. This allows you to search for specific users.
4. Select and click the display name of the user from the Search Results area. This opens the user details in a separate tab.
5. Click the Roles tab that appears under the user name.
6. Click **Assign**.

   The Add Role window appears.
7. Use the Advanced Search option to search for the **Tax Administrator** role. You can use the **Equals** options from the **Display Name** list and enter **Tax Administrator** in the text box next to the list.
8. Select the role in the Search Results area and click the **Add** button.

### How You Capture Electronic Invoice Information for Mexico

The Journals for Mexico report collects information on all transactions that are accounted and posted in different subledgers. The report also captures information related to electronic invoices generated for sales or received from suppliers for purchases. However, you must update the global descriptive flexfields when entering and posting transactions in Oracle Fusion Payables and Oracle Fusion Receivables.

Global descriptive flexfields store the unique identifier and invoice number issued either by the Tax Administration Services (SAT) or by an authorized service provider (PAC).

The following table summarizes the flexfields you must update for electronic invoices when you create an invoice or transaction in Payables and Receivables.

<table>
<thead>
<tr>
<th>Global Descriptive Flexfields</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Digital Tax Receipt using Internet Unique ID</td>
<td>Enter the unique identifier of the Comprobante Fiscal Digital por Internet. CFDI is an electronic billing schema that simplifies the process of issuing and receiving invoices and involves engaging an authorized certification provider.</td>
</tr>
<tr>
<td>Digital Tax Receipt Serial Number</td>
<td>Enter the serial number on the Digital Fiscal Document or Fiscal Document with Bidirectional Bar Code (CFD/CBB). CFD/CBB is a paper-based fiscal document that contains an authorized bidirectional bar code. This type of fiscal document is issued to taxpayers whose annual income is less than four million Mexican Pesos.</td>
</tr>
<tr>
<td>Digital Tax Receipt Invoice Number</td>
<td>Enter the invoice number on the CFD/CBB.</td>
</tr>
<tr>
<td>Foreign Invoice Number</td>
<td>Enter the foreign invoice number.</td>
</tr>
</tbody>
</table>

**Note:** To capture all the Mexican transactions correctly:
- In Payables, select **Payables Invoice Information for Mexico** from the **Regional Information** list on the invoice header.
- In Receivables, select **Receivables Transaction Information for Mexico** from the **Regional Information** list on the Miscellaneous tab on the transaction header.

If an invoice is paid in multiple installments, capture each payment separately. Update the GDFs with the details of your payment. You can access the GDFs from the:
- Payment Installments dialog window in Payables
- Review Installments dialog window in Receivables
Chart of Accounts for Mexico Report

This topic includes details about the Chart of Accounts for Mexico report.

Overview

Companies in Mexico must submit accounting information to the tax authorities. According to the new government regulations, companies must upload accounting information to the Tax Administration Services (SAT) internet portal through a registered e-mail account.

Note: You can use your taxpayer identification registry (RFC) to register your e-mail on the SAT portal.

Fiscal authorities in Mexico publish the official chart of accounts that all companies must use to report accounting information. This referential chart of accounts assigns a code to each account, and a level to identify parent-child relationships for reporting purposes. You must set up these codes in Oracle Fusion Applications.

The following figure is an example of the report:

Key Insights

You must map accounts from your company’s chart of accounts to the SAT agglutination codes in the Chart of Accounts Mapping page. Only the accounts that are mapped to the SAT agglutination codes are included in the report.

You can define the company’s natural account segment as a single level or a hierarchy. If you implement an account hierarchy, a child account can have a single parent account (recommended) or multiple parent accounts. When a child account has multiple parent accounts, only the immediate parent appears on the report. You can map more than one account to a given SAT agglutination code.

Before you run the report, ensure the natural accounts appear at the correct level in the account hierarchy. Perform the following steps to update the level of natural account according to the account hierarchy:

1. In the Setup and Maintenance work area, go to the following:
   - Offering: Financials
   - Functional Area: Financial Reporting Structures
   - Task: Manage Account Hierarchies
2. On the Manage Account Hierarchies page, select the account.
3. From the Actions menu, select Flatten and click Row Flattening.
4. Click Force Flatten.
5. From the Actions menu, select Flatten and click Column Flattening.
6. Click Force Flatten.

Note: You must enable the Chart of Accounts for Mexico process so that you can run it from the Scheduled Processes page. For more information, see the Enabling Mexican Reporting Processes: Procedure topic.

Report Parameters
The following table describes selected process parameters.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Seal</td>
<td>Enter the digital electronic seal information provided by the fiscal partner.</td>
</tr>
<tr>
<td>Certificate Number</td>
<td>Enter the certificate number information provided by the fiscal partner.</td>
</tr>
<tr>
<td>Certificate</td>
<td>Enter certificate information provided by the fiscal partner.</td>
</tr>
<tr>
<td>Format Version</td>
<td>Enter the format version of the file defined by the Government of Mexico. It can change over time, such as 1.1, 1.2, and 2.0.</td>
</tr>
<tr>
<td>Chart of Accounts Mapping</td>
<td>Enter the chart of accounts mapping created for Mexico.</td>
</tr>
<tr>
<td>Legal Entity</td>
<td>Enter the legal entity, which determines the RFC number to be stamped on the report.</td>
</tr>
</tbody>
</table>

Frequently Asked Questions
The following table lists frequently asked questions about the Chart of Accounts for Mexico report.

<table>
<thead>
<tr>
<th>FAQ</th>
<th>Answer</th>
</tr>
</thead>
<tbody>
<tr>
<td>How do I find this report?</td>
<td>Schedule and run this report from the Scheduled Processes work area on the Navigator menu.</td>
</tr>
<tr>
<td>Who uses this report?</td>
<td>Financial accountant</td>
</tr>
<tr>
<td>When do I use this report?</td>
<td>Use this report to provide detailed chart of accounts information to the tax authorities in Mexico.</td>
</tr>
<tr>
<td>What type of report is this?</td>
<td>Oracle Business Intelligence Publisher</td>
</tr>
</tbody>
</table>

How You Configure Chart of Accounts for Mexico Report
The Chart of Accounts for Mexico report displays all the mapped accounts of your company and the corresponding SAT accounts in XML format.
Before you run the Chart of Accounts for Mexico report process, you must complete the following setup steps:

- Set up the company’s Taxpayer Identification Registry (RFC)
- Define a value set and values for the company segment
- Define a value set and values for the account segment
- Define the contra account for Mexico
- Define a value set and values for the contra account segment
- Define the chart of accounts
- Define the chart of accounts mapping

**Set Up Taxpayer Identification Registry for the Company**

Update the legal entity to specify the taxpayer identification registry (RFC). Use the Manage Legal Entity Registrations task in the Define Legal Entities task list to update the RFC.

**Define Value Set and Values for Company Segment**

Use the Manage Chart of Accounts Value Set page to create value set for the company segment. Use the Manage Values page to create the values for the company segment value set.

**Define Value Set and Values for Account Segment**

Use the Manage Chart of Accounts Value Set page to create value set for the account segment. Use the Manage Values page to create the values for the account segment value set.

**Note:** To correctly map the source accounts of your company to the SAT target accounts, don’t define the SAT level 1 accounts (such as 1, 2, 3 and so on) as parents of SAT level 2 accounts (such as 1.1, 1.2, 2.1, and so on). The SAT account segment doesn’t require a hierarchy definition.

**Define Contra Account for Mexico**

The contra account segment label indicates the contra accounts that are reported in the Chart of Accounts for Mexico report.

Define contra accounts (rectifier accounts) for offset account types such as assets, liabilities, and owner equity. You must correctly identify and mark your contra accounts.

In the Chart of Accounts for Mexico report, the contra accounts are displayed in the Natur field of the Ctas element with reversed values, as described in the following table:

<table>
<thead>
<tr>
<th>Account Type Code</th>
<th>Description</th>
<th>Debit or Credit</th>
<th>Field Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Assets</td>
<td>DR</td>
<td>D</td>
</tr>
<tr>
<td>A</td>
<td>Rectifier Assets</td>
<td>CR</td>
<td>A</td>
</tr>
<tr>
<td>L</td>
<td>Liability</td>
<td>CR</td>
<td>A</td>
</tr>
<tr>
<td>O</td>
<td>Owner Equity</td>
<td>CR</td>
<td>A</td>
</tr>
<tr>
<td>L</td>
<td>Rectifier Liability</td>
<td>DR</td>
<td>D</td>
</tr>
</tbody>
</table>
Use the Manage Segment Labels page to create a new contra segment for Mexico.

Define Value Set and Values for Contra Account Segment
Use the Manage Chart of Accounts Value Set page to create a value set for the contra account segment. Use the Manage Values page to create the values for the contra account segment value set.

Define Chart of Accounts
Define the SAT chart of accounts for Mexico and include the:
- Company account segment
- Account segment
- Contra account segment

Define Chart of Accounts Mapping
Define the chart of accounts mapping with source as the primary chart of accounts of your company and target as the SAT chart of accounts.

It is recommended that you map the natural account segment values between the chart of accounts of your company and the SAT chart of account. Use the:
- Assign single value as the mapping method for the company target segment.
- Use rollup rules as the mapping method and Account as the source segment for the account target segment.
- Use rollup rules as the mapping method and Account as the source segment for the contra account target segment.

If the source accounts are contra in nature, create a rollup rule and map the target value to the source account values (the primary chart of accounts).

Journals for Mexico Report
This topic includes details about the Journals for Mexico report.

Overview
Companies in Mexico must submit accounting information to the tax authorities. According to the new government regulations, companies must upload accounting information to the Tax Administration Services (SAT) internet portal through a registered e-mail account.

Note: You can use your taxpayer identification registry (RFC) to register your e-mail address on the SAT portal.

The Journals for Mexico report collects information on all transactions that are accounted and posted in different subledgers. The report also captures information related to electronic invoices generated for sales or received from suppliers for
Oracle Financials Cloud
Using Financials for the Americas

Chapter 1
Financials for Mexico

Key Insights
To run the report, you must first enable the Journals for Mexico process so that you can run it from the Scheduled Processes page. For more information, see Enabling Mexican Reporting Processes: Procedure.

When you run the Journals for Mexico process, detailed transaction information is extracted from Oracle Fusion General Ledger for the specified period.

The report is generated in an XML format and includes the following sections:

- **Heading**: Includes layout version, RFC number, and the date on which the report is generated.
- **Details**: Provides accounting information from the journal entries.

> Note: Records in the journal entries are grouped based on your Payables and Receivables settings.

Report Parameters
The following table describes selected process parameters.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Request Type</td>
<td>Select the audit request type indicated by the Government.</td>
</tr>
<tr>
<td>Audit Request Number</td>
<td>Specify the audit request number, when the request type is audit event (AF) or on-site audit (FC).</td>
</tr>
<tr>
<td>Audit Process Number</td>
<td>Specify the audit process number, when the request type is return (DE) or compensation (CO).</td>
</tr>
</tbody>
</table>
### Parameter | Description
--- | ---
Journal Version | Enter the format version of the file defined by the Government of Mexico. It can change over time, such as 1.1, 1.2, and 2.0.
Seal Number | Specify the digital electronic seal provided by the Government for the accounting file.
Certificate Number | Specify the digital certificate seal that protects the electronic accounting file.
Digital Seal Certificate | Specify digital seal certificate that protects the electronic accounting file.
Journal Source | Specify the name of the journal source. When you specify the source, the journal lines from that source are extracted. When you specify **ALL**, journal lines from all the subledgers are extracted.
Show Adjustment Periods | Specify whether data during the adjustment period must be extracted and reported.
Ledger | Specify the ledger from which you want to extract data. When you specify a ledger, only posted journal lines in that ledger are extracted.
From Period and To Period | Specify the range of subledger periods to be included for extracting data.
Posting Status | Specify whether posted data must be included in the report.
Include Zero Amount Lines | Specify whether zero amount lines must be included in the report.

### Frequently Asked Questions
The following table lists frequently asked questions about the Journals for Mexico report.

<table>
<thead>
<tr>
<th>FAQ</th>
<th>Answer</th>
</tr>
</thead>
<tbody>
<tr>
<td>How do I find this report?</td>
<td>Schedule and run this report from the Scheduled Processes work area on the Navigator menu.</td>
</tr>
<tr>
<td>Who uses this report?</td>
<td>Financial accountant</td>
</tr>
<tr>
<td>When do I use this report?</td>
<td>Use this report to provide detailed accounting information to the tax authorities in Mexico.</td>
</tr>
<tr>
<td>What type of report is this?</td>
<td>Oracle Business Intelligence Publisher</td>
</tr>
</tbody>
</table>
Trial Balance Report for Mexico

This topic contains summary information about the Trial Balance Report for Mexico.

Overview

The trial balance report is an XML file that includes a summary of the initial balances, the sum of total transactions for the period, and the final balances for each account that you report in the Chart of Accounts XML file. The accounts related to assets, liabilities, equity, and results of operations (revenues, costs and expenses) are all included.

Key Insights

After generating the report, convert the report to an XML format so that it’s ready to upload to the Tax Administration Services (SAT) website.

You can create the report once and use it periodically. The report can also be modified based on the requirements from the Federal Government.

Frequently Asked Questions

The following table lists frequently asked questions about the Trial Balance Report for Mexico.

<table>
<thead>
<tr>
<th>FAQs</th>
<th>Answer</th>
</tr>
</thead>
<tbody>
<tr>
<td>How do I find this report?</td>
<td>Run this report from your folder in the General Accounting: Financial Reporting Center.</td>
</tr>
</tbody>
</table>
| Who uses this report?     | • Financial Accountants  
                           | • Financial Specialists                                                |
| When do I use this report? | Use the Trial Balance Report for Mexico to know the summary of the initial balances, the sum of total transactions for the period, and the final balances for each account that you report in the Chart of Accounts XML file. |
| What type of report is this? | Oracle Business Intelligence Publisher                                  |

Create a Trial Balance Report for Mexico

The trial balance report is an XML file that includes a summary of the initial balances, the sum of total transactions for the period, and the final balances for each account in the Chart of Accounts XML file. The report includes information on accounts related to assets, liabilities, equity, and the results of operations (revenues, costs and expenses).

Use the Oracle Hyperion Financial Reporting Studio to create the Trial Balance Report for Mexico. You can create the report once and use it periodically. The report can also be modified based on the requirements from the Federal Government.

Perform the following steps to create the report:

1. Access the Financial Reporting Studio on your desktop.
2. Click File > New > Report or click the New Report icon.
3. Use the Report Pallet page as the container to build your report.
4. Click **Insert > Grid...** or click the **New Grid** icon.

5. Click and hold the left mouse button to select a large area of the grid to create the report.

   The Select a Database Connection dialog box appears when you release the mouse after setting the size and position of the grid.

6. Click the **Database Connection** list.

7. Select your database. A unique cube exists for each combination of chart of accounts and accounting calendar.

   ![Note](image) **Note:** The user name and password are the login credentials you used to access the Financial Reporting Studio.

8. Click **OK**.

   The Dimension Layout dialog box appears. Set the point of view dimensions and accounts for the rows, columns, and page levels.

9. Use the Dimension Layout dialog box to arrange your dimensions. Move:

   - **Accounting Period** and **Balance Amount** to **Columns**.
   - **Account** to **Rows**.

   ![Tip](image) **Tip:** Click the icon in front of the name to select the dimension to move to the designed area.
The following figure illustrates how the dimensions appear on the Dimension Layout dialog box after you made your selection.

10. **Click OK.**
    You will return to the grid which has the selected dimensions.
11. **Add additional rows and columns to the grid according to your requirement.**
    - Columns: Copy column A and paste it four times to see columns A to E.
    - Rows: Select row 1, right-click and select **Insert Row > Text**. Insert ten rows.
12. **Enter the row text in each row cell.** The following table lists the row text for each row.

<table>
<thead>
<tr>
<th>Row</th>
<th>Text</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Note: You can update the version number anytime.</td>
</tr>
<tr>
<td>2</td>
<td>Note: You can update the RFC anytime.</td>
</tr>
<tr>
<td>3</td>
<td>Mes=&quot;&lt;&lt;MemberName(&quot;Grid1&quot;, &quot;AccountingPeriod&quot;)&gt;&gt;&quot;</td>
</tr>
<tr>
<td>Row</td>
<td>Text</td>
</tr>
<tr>
<td>-----</td>
<td>------</td>
</tr>
<tr>
<td>4</td>
<td>Anio=&quot;&lt;&lt;MemberName(&quot;Grid1&quot;, E, &quot;AccountingPeriod&quot;)&gt;&gt;&quot;</td>
</tr>
<tr>
<td>5</td>
<td>TipoEnvio=&quot;N&quot; (User need to fill value)</td>
</tr>
<tr>
<td>6</td>
<td>FechaModBal=&quot; &quot; (User need to fill value)</td>
</tr>
<tr>
<td>7</td>
<td>Sello=&quot;Seal&quot; (User need to fill value)</td>
</tr>
<tr>
<td>8</td>
<td>noCertificado =&quot;13&quot; (User need to fill value)</td>
</tr>
<tr>
<td>9</td>
<td>Balanza Certificado =&quot;cERT&quot; (User need to fill value)</td>
</tr>
<tr>
<td>10</td>
<td>Update the row cell and columns for row 10 with the following values:</td>
</tr>
<tr>
<td></td>
<td>- Row cell with NumCta</td>
</tr>
<tr>
<td></td>
<td>- Row 10, Column A with Saldo Ini</td>
</tr>
<tr>
<td></td>
<td>- Row 10, Column B with Debe</td>
</tr>
<tr>
<td></td>
<td>- Row 10, Column C with Haber</td>
</tr>
<tr>
<td></td>
<td>- Row 10, Column D with SaldoFin</td>
</tr>
</tbody>
</table>

The following figure illustrates how the grid appears after you have inserted the text.

13. In the first column on the grid (Column A), double-click the **AccountingPeriod** cell.
The Select Members dialog box appears.

14. Remove the default selection from the Selected pane and assign a user-defined period selection.
15. Select the AccountingPeriod in the Selected pane and click Remove.
16. Select Current Point of View for Accounting Period from Available pane and click Move to place it in the Selected pane.
17. Select the Place selection into separate columns option.
18. Click OK.
19. Repeat the steps for Columns B, C, and D.
20. In the last column on the grid (Column E), double-click the AccountingPeriod cell to open the Select Members dialog box.
21. Select the AccountingPeriod in the Selected pane and click Remove.
22. Select Current Point of View for Accounting Period from Available pane and click Move to place it in the Selected pane.
23. Click the Functions tab and select RelativeMember from the list.
24. Click Add.
25. Use the Edit RelativeMember Function dialog box to add the parameter values. The following table lists the values you can enter.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Member</td>
<td>Current Point of View for Accounting Period</td>
</tr>
<tr>
<td>Offset</td>
<td>0</td>
</tr>
<tr>
<td>Hierarchy</td>
<td>AccountingPeriod</td>
</tr>
<tr>
<td>RelativeMemberList</td>
<td>Fiscal Year</td>
</tr>
</tbody>
</table>

26. Select the Place selection into separate columns option.
27. Click OK.
28. In the first column on the grid (Column A), double-click the BalanceAmount cell. The Select Members dialog box appears.
29. Remove the default selection from the Selected pane and assign a user-defined selection.
30. Expand the Balance Amount node in the Available pane and select Beginning Balance.
31. Click Move.
32. Select the Place selection into separate columns option.
33. Click OK.
34. Repeat the steps and assign the user-defined properties as shown in the table for the BalanceAmount cell in the other columns.

<table>
<thead>
<tr>
<th>Column</th>
<th>Parent Node</th>
<th>Custom Selection</th>
</tr>
</thead>
<tbody>
<tr>
<td>B</td>
<td>Period Activity</td>
<td>Period Activity Dr</td>
</tr>
<tr>
<td>C</td>
<td>Period Activity</td>
<td>Period Activity Cr</td>
</tr>
<tr>
<td>D</td>
<td>Ending Balance</td>
<td>Ending Balance</td>
</tr>
<tr>
<td>E</td>
<td>Ending Balance</td>
<td>Ending Balance</td>
</tr>
</tbody>
</table>
The following figure illustrates how your grid will appear when you finish updating user-defined values for all the dimensions.

![Grid illustration](image)

35. Select column E.

The Custom Properties dialog box appears.

36. Select the **Hide Always** check box.
37. Select the first two rows (row 1 and 2).
38. Select the **Hide Always** check box in the Custom Properties dialog box.
39. Select row 11, right-click and click **Insert Row > Data**. Row 12 is added.

**Note:** For each account in the SAT chart of accounts mapping, add a row.

40. Double-click the **Account** cell in row 11 to open the Select Members dialog box.
41. Select **Account** in the Selected pane and click **Remove**.
42. Click the Members tab.
43. Expand the **Account > All Account Values** nodes that appear in the Available pane.
44. Select **1110** and click **Move**. The account appears in the Selected pane.
45. Select the **Place selection into separate columns** option.
46. Click **OK**.

You can follow the similar steps to add all your natural accounts.

47. Update the dimensions that appear in the grid with the values specified in the following table.
**Note:** To update the dimensions, double-click the respective dimension buttons to open the Select Members dialog box. Select the values as specified in the table in the Select Members dialog box and click **OK**.

<table>
<thead>
<tr>
<th>Dimension</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>AccountingPeriod</td>
<td>Qtr1-00 for the year 2000</td>
</tr>
</tbody>
</table>

**Note:** Run the report either for a year or for any quarter of a year.

<table>
<thead>
<tr>
<th>Scenario</th>
<th>Actual</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ledger</td>
<td>Vision Operation</td>
</tr>
</tbody>
</table>

**Note:** Run the report for any ledger.

<table>
<thead>
<tr>
<th>Amount Type</th>
<th>Base</th>
</tr>
</thead>
<tbody>
<tr>
<td>Currency</td>
<td>MXN</td>
</tr>
<tr>
<td>Currency Type</td>
<td>Entered</td>
</tr>
</tbody>
</table>

48. Set the grid properties. Select the grid to open the Grid Properties dialog box. In the Suppression region, check the following check boxes:
   - **Basic Options**
   - **If Zero, Suppress**
   - **If Missing, Suppress**
   - **If Error, Suppress**

49. Save the report.

### Convert the Trial Balance Report for Mexico to XML Format

You can view the Trail Balance Report for Mexico from the Financial Reporting Center. After you have viewed the report, you can convert it to an XML format to upload it to the Tax Administration Services (SAT) internet portal.

### View the Trial Balance Report for Mexico

To view the report, perform the following steps:

1. Sign in the Oracle Fusion Applications.
3. View the report in HTML.
4. Click the **HTML Preview** list at the beginning of the page and select **Export to Excel**.

   The report opens in Microsoft Excel.

5. Save the report in your local folder as an **Excel Macro-Enabled Workbook**.

### Convert the Trial Balance Report for Mexico to XML Format

Perform the following steps to convert your report to an XML format that can be uploaded to the SAT portal:

1. Open the report in Microsoft Excel and click the View tab.
2. Click **Macros > View Macros**.
3. Enter **GenerateXML** in the **Macro name** field and click **Create**.

   The Microsoft Visual Basic editor opens.

4. Copy and paste the following report conversion code in the Microsoft Visual Basic editor.

```vbscript
Sub GenerateXML()
    ' GenerateXML Macro
    Dim Version As String
    Dim RFC As String
    Dim Mes As String
    Dim Anio As String
    Dim TipoEnvio As String
    Dim FechaModBal As String
    Dim Sello As String
    Dim noCertificada As String
    Dim BalanzaCertificada As String
    Dim XML As String
    Dim XML2 As String
    Dim Row As String
    Dim Row2 As String
    Dim ColumnName As String
    Dim ColumnValue As String
    Dim MesP1 As String
    Dim MesP2 As String
    Dim Pos As Integer
    Dim Pos2 As Integer
    Dim Pos3 As Integer
    Dim MidStr As String
    Dim MidStr2 As String
    Dim Arr

    Sheets(1).Select
    Version = Replace(ActiveSheet.Cells(3, 1).Value, " ", ")
    RFC = Replace(ActiveSheet.Cells(4, 1).Value, " ", ")
    Mes = Replace(ActiveSheet.Cells(5, 1).Value, " ", ")
    Anio = Replace(ActiveSheet.Cells(6, 1).Value, " ", ")
    TipoEnvio = Replace(ActiveSheet.Cells(7, 1).Value, " ", ")
    FechaModBal = Replace(ActiveSheet.Cells(8, 1).Value, " ", ")
    Sello = Replace(ActiveSheet.Cells(9, 1).Value, " ", ")
    noCertificada = Replace(ActiveSheet.Cells(10, 1).Value, " ", ")
    BalanzaCertificada = Replace(ActiveSheet.Cells(11, 1).Value, " ", ")

    MesP1 = Mid(Mes, 6, 3)
    ' MsgBox MesP1
    If (MesP1 = "Jan") Or (MesP1 = "Ene") Or (MesP1 = "ENE") Or (MesP1 = "JAN") Then
        MesP2 = "Mes=" & Chr(34) & "01" & Chr(34)
    ElseIf (MesP1 = "Feb") Or (Mes = "FEB") Then
        MesP2 = "Mes=" & Chr(34) & "02" & Chr(34)
    ElseIf (MesP1 = "Mar") Or (MesP1 = "Mar") Or (MesP1 = "MAR") Then
        MesP2 = "Mes=" & Chr(34) & "03" & Chr(34)
    ElseIf (MesP1 = "Apr") Or (MesP1 = "Abr") Or (MesP1 = "ABR") Then
        MesP2 = "Mes=" & Chr(34) & "04" & Chr(34)
    ElseIf (MesP1 = "May") Or (MesP1 = "May") Or (MesP1 = "MAY") Then
        MesP2 = "Mes=" & Chr(34) & "05" & Chr(34)
    ElseIf (MesP1 = "Jun") Or (MesP1 = "Jun") Or (MesP1 = "JUN") Then
        MesP2 = "Mes=" & Chr(34) & "06" & Chr(34)
    ElseIf (MesP1 = "Jul") Or (MesP1 = "Jul") Or (MesP1 = "JUL") Then
        MesP2 = "Mes=" & Chr(34) & "07" & Chr(34)
    ElseIf (MesP1 = "Aug") Or (MesP1 = "Ago") Or (MesP1 = "AGO") Then
        MesP2 = "Mes=" & Chr(34) & "08" & Chr(34)
    ElseIf (MesP1 = "Sep") Or (MesP1 = "Sep") Or (MesP1 = "SEP") Then
        MesP2 = "Mes=" & Chr(34) & "09" & Chr(34)
    ElseIf (MesP1 = "Oct") Or (MesP1 = "Oct") Or (MesP1 = "OCT") Then
        MesP2 = "Mes=" & Chr(34) & "10" & Chr(34)
    ElseIf (MesP1 = "Nov") Or (MesP1 = "Nov") Or (MesP1 = "NOV") Then
        MesP2 = "Mes=" & Chr(34) & "11" & Chr(34)
    ElseIf (MesP1 = "Dec") Or (MesP1 = "Dic") Or (MesP1 = "DIC") Then
        MesP2 = "Mes=" & Chr(34) & "12" & Chr(34)
    Else
        MesP2 = "Mes=" & Chr(34) & "
```
ElseIf (MesP1 = "Mar") Or (Mes = "MAR") Then
MesP2 = "Mes=" & Chr(34) & "03" & Chr(34)
ElseIf (MesP1 = "Apr") Or (Mes = "Abr") Or (MesP1 = "ABR") Or (MesP1 = "APR") Then
MesP2 = "Mes=" & Chr(34) & "04" & Chr(34)
ElseIf (MesP1 = "May") Or (MesP1 = "MAY") Then
MesP2 = "Mes=" & Chr(34) & "05" & Chr(34)
ElseIf (MesP1 = "Jun") Or (MesP1 = "JUN") Then
MesP2 = "Mes=" & Chr(34) & "06" & Chr(34)
ElseIf (MesP1 = "Jul") Or (MesP1 = "JUL") Then
MesP2 = "Mes=" & Chr(34) & "07" & Chr(34)
ElseIf (MesP1 = "Aug") Or (MesP1 = "AGO") Or (MesP1 = "AGO") Then
MesP2 = "Mes=" & Chr(34) & "08" & Chr(34)
ElseIf (MesP1 = "Sep") Or (MesP1 = "SEP") Then
MesP2 = "Mes=" & Chr(34) & "09" & Chr(34)
ElseIf (MesP1 = "Oct") Or (MesP1 = "OCT") Then
MesP2 = "Mes=" & Chr(34) & "10" & Chr(34)
ElseIf (MesP1 = "Nov") Or (MesP1 = "NOV") Then
MesP2 = "Mes=" & Chr(34) & "11" & Chr(34)
ElseIf (MesP1 = "Dec") Or (MesP1 = "DEC") Or (MesP1 = "Dic") Or (MesP1 = "DIC") Then
MesP2 = "Mes=" & Chr(34) & "12" & Chr(34)
Else
MesP2 = "Mes=" & Chr(34) & "13" & Chr(34)
End If

' MsgBox MesP2

XML = XML & '"BCE:Balanza xmlns:BCE=" & Chr(34) & "http://www.sat.gob.mx/esquemas/ContabilidadE/1_1/BalanzaComprobacion" & Chr(34) & " xmlns:xsi=" & Chr(34) & "http://www.w3.org/2001/XMLSchema-instance" & Chr(34) & " xsi:schemaLocation=" & Chr(34) & "http://www.sat.gob.mx/esquemas/ContabilidadE/1_1/BalanzaComprobacion http://www.sat.gob.mx/esquemas/ContabilidadE/1_1/BalanzaComprobacion_1_1.xsd" & Chr(34)
XML2 = XML
Row2 = ""

'Pos is Position of Inverted Commas from Start
'Pos2 is Length of String between Inverted Commas
'Pos3 is Length of Field Name

For I = 3 To 11
Pos = InStr(1, Replace(ActiveSheet.Cells(I, 1).Value, " ", ""), Chr(34)) + 1
Pos2 = InStr(Pos, Replace(ActiveSheet.Cells(I, 1).Value, " ", ""), Chr(34))
Pos2 = Pos2 - Pos
Pos2 = Pos2 - 3
MidStr = Mid(Replace(ActiveSheet.Cells(I, 1).Value, " ", ""), Pos, Pos2)
MidStr2 = Mid(Replace(ActiveSheet.Cells(I, 1).Value, " ", ""), 1, Pos3)
'MsgBox MidStr2
If MidStr <> "" Then
Row2 = Row2 & MidStr & ""
Else
Row2 = Row2 & MidStr2 & "" & Chr(34) & MidStr & Chr(34) & ""
End If
'Row2 = Row2 & "" & Replace(ActiveSheet.Cells(I, 1).Value, " ", "")
'MsgBox Row2
End If

Next I
'MsgBox XML2
'MsgBox Row2

XML2 = XML2 & " " & Row2

XML = XML2 & "">" & vbNewLine

ActiveSheet.Range("A13").Select
Selection.End(xlDown).Select
SheetLastRow = ActiveCell.Row

ActiveSheet.Range("A13").Select
Selection.End(xlToRight).Select
SheetLastColumn = ActiveCell.Column

For I = 13 To SheetLastRow
Row = vbTab & "<BCE:Ctas"
For J = 1 To SheetLastColumn
ColumnName = Replace(ActiveSheet.Cells(12, J).Value, " ", "")
If ColumnName = "SaldoIni" Or ColumnName = "Debe" Or ColumnName = "Haber" Or ColumnName = "SaldoFin" Then
ColumnValue = ActiveSheet.Cells(I, J).Value
'Selection.NumberFormat = ",#
Else
ColumnValue = ActiveSheet.Cells(I, J).Value
End If
Row = Row & ColumnName & ";" & Chr(34) & ColumnValue & Chr(34) & " ">
Next J
Row = Row & "/>" & vbNewLine
Next I

XML = XML & Row
Next I

XML = XML & "</BCE:Balanza>"

fileSaveName = Application.GetSaveAsFilename(ActiveSheet.Name, fileFilter:="XML Files (*.xml), *.xml")

Open fileSaveName For Output As #1
Print #1, "<?xml version=" & Chr(34) & "1.0" & Chr(34) & " encoding=" & Chr(34) & "UTF-8" & Chr(34) & "?>"
Print #1, XML
Close #1
End Sub

5. Click File > Save.

Save the file in your local folder and close Microsoft Visual Basic.

6. Select the GenerateXML macro and click Run that appears on the Macros dialog box in Microsoft Excel.

7. Save the XML file in your local folder.

8. Open the XML file and verify the output.
Auxiliary Report for Mexico

This topic contains summary information about the Auxiliary Report for Mexico.

Overview

The Auxiliary Report for Mexico helps with an in-depth analysis of all accounting entries for a given account in a given period. The report displays beginning and ending balance, as well as the daily journals entries posted to that account during the period.

Key Insights

After generating the report, convert the report to an XML format so that it’s ready to upload to the Tax Administration Services (SAT) website.

Frequently Asked Questions

The following table lists frequently asked questions about the Auxiliary Report for Mexico.

<table>
<thead>
<tr>
<th>FAQs</th>
<th>Answer</th>
</tr>
</thead>
<tbody>
<tr>
<td>How do I find this report?</td>
<td>In Oracle Business Intelligence Enterprise Edition, select Analysis from Analysis and Interactive Reporting.</td>
</tr>
</tbody>
</table>
| Who uses this report?    | • Financial Accountants  
                          | • Financial Specialists       |
| When do I use this report? | Use the Auxiliary Report for Mexico when you need to provide detailed records of your accounts to the fiscal authorities. |
| What type of report is this? | Oracle Transaction Business Intelligence |

Configure the General Ledger Segments for Reporting in OTBI

Before you generate the Auxiliary Report for Mexico, you need to configure and enable the general ledger segments for reporting in OTBI.

Perform the following tasks to configure and enable general ledger segments for reporting:

1. Enable the chart of accounts segments for BI reporting.
2. Map the accounting segments with the corresponding BI Object Name.
3. Deploy flexfields.
4. Run the Import Oracle Fusion Data Extensions for Transactional Business Intelligence process.

Enable the Chart of Accounts Segments

You must enable your accounting segments for OTBI reporting before using them. Perform the following steps to use the accounting segments in OTBI:

1. Navigate to Setup and Maintenance work area.
2. Select an implementation project.
3. In the Task Lists and Tasks section, select **Financials > Define Common Applications Configurations for Financials > Define Common Reference Objects for Financials > Manage Key Flexfields**.
   The Manage Key Flexfields page appears.
4. Enter **GL#** in the **Key Flexfield Code** field and click **Search**.
5. Click Manage Structure Instances.
   The Manage Key Flexfield Structure Instances page appears.
6. Use the search fields to search for your key flexfield structure instances.
7. Select your key flexfield structure instances from the Search Results.
8. Click the Actions menu and then click **Edit**.
   The Edit Key Flexfield Structure Instance page appears.
9. Select the segment instance that you want to use in OTBI from the **Segment Instances** table.
10. Click the Actions menu and then click **Edit**.
    The Edit Key Flexfield Segment Instance dialog box appears.
11. Select the BI enabled check box and click the **OK** button.
12. Click **Save**.
13. Repeat the steps for all the segment instances that you want to use in OTBI.

### Map the Accounting Segments and BI Object Name

Populate the BI Object Name for each of the Segment Labels that want to use in OTBI for reporting and analysis. The BI metadata has ten predefined BI Objects for the different GL segments. These BI Objects are used as dimensions in OTBI for the selected GL segments.

Perform the following steps to map the different chart of account segments to the predefined BI objects:

1. Navigate to Setup and Maintenance work area.
2. Select an implementation project.
3. In the Task Lists and Tasks section, select **Financials > Define Common Applications Configurations for Financials > Define Common Reference Objects for Financials > Manage Key Flexfields**.
   The Manage Key Flexfields page appears.
4. Enter **GL#** in the **Key Flexfield Code** field and click **Search**.
5. Click the Actions menu and then click the Manage Segment Labels option.
   The Manage Segment Labels page appears.
6. Update the BI Object Name for all the segment labels that are required. For the following three segment label codes, specify the BI Object name as specified in the table. Do not modify the BI object name; use the BI object name as mentioned in the following table.

<table>
<thead>
<tr>
<th>Segment Label Code</th>
<th>BI Object Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>FA_COST_CTR</td>
<td>Dim - Cost Center</td>
</tr>
<tr>
<td>GL_BALANCING</td>
<td>Dim - Balancing Segment</td>
</tr>
<tr>
<td>GL_ACCOUNT</td>
<td>Dim - Natural Account Segment</td>
</tr>
</tbody>
</table>

7. For the other non-qualified segment labels that you want to use in OTBI, use any BI object names from Dim - GL Segment1 to Dim - GL Segment10.
For the Auxiliary report for Mexico, map the segment label MX_SUBACCOUNT to Dim - GL Segment9.

**Deploy Flexfields**

Perform the following steps to deploy the flexfields:

1. Navigate to Setup and Maintenance work area.
2. In the Setup and Maintenance work area, go to the following:
   - Offering: Financials
   - Functional Area: Financial Reporting Structures
   - Task: Manage Chart of Accounts Structure
3. On the Manage Chart of Accounts Structure page, enter GL# in the Key Flexfield Code field and click Search.
4. Click Deploy Flexfield.
   - The GL#: Processing dialog box appears indicating the deployment progress.
5. Click the OK button after the deployment completes.

**Run the Import Oracle Fusion Data Extensions for Transactional Business Intelligence Process**

Perform the following steps to run the Import Oracle Fusion Data Extensions for Transactional Business Intelligence process:

1. Navigate to the Scheduled Processes work area.
2. Click the Schedule New Process button.
   - The Schedule New Process dialog box appears.
3. Click Name.
4. Click Search.
   - The Search and Select dialog box appears.
5. Enter Import Oracle Fusion Data Extensions for Transactional Business Intelligence in the Name field.
6. Click Search.
7. Select the process name from the Search Results area and click the OK button.
8. Click the OK button on the Schedule New Process dialog box.
   - The Process Details dialog box appears.
9. Update the details and click the Submit button.
10. Note the Process ID and click OK to acknowledge that your process was submitted.
11. Note the status of your process:
    - If the status of the process is Succeeded, the process executed successfully. Proceed and generate the Auxiliary Report for Mexico.
    - If the status of the process is failed, check the log file, make corrections, and submit the process again.

**Generate the Auxiliary Report for Mexico**

The Auxiliary Report for Mexico provides a detailed analysis of all accounting entries for a given account during a given period. The report displays beginning and ending balances, as well as the daily journal entries posted to an account during a specific period.
Use the Auxiliary Report for Mexico to provide detailed records of your accounts to the fiscal authorities.

Prerequisites

Complete the following steps before you generate the Auxiliary Report for Mexico:

2. Click Catalog.
3. Click New > Folder on the catalog tool bar.
4. Create a local folder in My Folders.
5. Enter the Name of the folder as Mexico and click OK.

The new folder appears in the folder pane in My Folders.
6. Select the Mexico folder and click the Expand icon.
7. Click the New icon that appears on the toolbar.
8. Click the Analysis option that appears in Analysis and Interactive Reporting.
9. Enter the following SQL statement in the Create Analysis from Simple Logical SQL option:

```sql
SELECT NumCta saw_0, DesCta saw_2, SaldoIni saw_4, SaldoFin saw_5, Fecha saw_6, NumUnIdenPol saw_7, Concepto saw_8, Debe saw_9, Haber saw_10, Accounting_Period saw_11, Ledger saw_12, Legal_Entity saw_13
FROM (SELECT "General Ledger - Transactional Balances Real Time"."Account"."General Ledger Code Combination Identifier" bal_ccid,
        "General Ledger - Transactional Balances Real Time"."Ledger"."Ledger Name" Ledger,
        "General Ledger - Transactional Balances Real Time"."Time"."Fiscal Period" Accounting_Period,
        "General Ledger - Transactional Balances Real Time"."Natural Account Segment"."Account Code" NumCta,
        "General Ledger - Transactional Balances Real Time"."Natural Account Segment"."Account Description" DesCta,
        "General Ledger - Transactional Balances Real Time"."- Balance"."Beginning Balance" SaldoIni,
        "General Ledger - Transactional Balances Real Time"."- Balance"."Ending Balance" SaldoFin,
        "General Ledger - Transactional Balances Real Time"."- Balance"."Period Net Activity" bal_periodbal
FROM "General Ledger - Transactional Balances Real Time" where "General Ledger - Transactional Balances Real Time"."Ledger"."Ledger Name" in ('@{p_ledger}') and "General Ledger - Transactional Balances Real Time"."Time"."Fiscal Period" in ('@{p_period}') ) balances full outer join (SELECT "General Ledger - Journals Real Time"."- Header Details"."Header Default Effective Date" Fecha,
        "General Ledger - Journals Real Time"."- Account"."General Ledger Code Combination Identifier" jrnl_ccid,
        "General Ledger - Journals Real Time"."- Header Details"."Header Description" jrnl_header_desc,
        "General Ledger - Journals Real Time"."- Header Details"."Header Name" NumUnIdenPol,
        "General Ledger - Journals Real Time"."- Ledger"."Ledger Name" jrnl_ledger,
        "General Ledger - Journals Real Time"."- Time"."Fiscal Period" jrnl_period,
        "General Ledger - Journals Real Time"."- Line Details"."Line Description" Concepto,
        "General Ledger - Journals Real Time"."- Lines"."Journal Line Accounted Amount Credit" Haber,
        "General Ledger - Journals Real Time"."- Lines"."Journal Line Accounted Amount Debit" Debe,
        "General Ledger - Journals Real Time"."- Header Details"."Journal Legal Entity" Legal_Entity
FROM "General Ledger - Journals Real Time"
where
"General Ledger - Journals Real Time"."- Ledger"."Ledger Name" in ('@{p_ledger}')
and "General Ledger - Journals Real Time"."- Time"."Fiscal Period" in ('@{p_period}')
and "General Ledger - Journals Real Time"."- Header Details"."Journal Legal Entity" in
('@{p_legal_entity}') and "General Ledger - Journals Real Time"."Posting Status"."Posting Status Code" = 'P' ) i journals on journals.jrnl_ledger = balances.Ledger and balances.bal_ccid = journals.jrnl_ccid and journals.jrnl_period = balances.Accounting_Period ORDER BY saw_0, saw_4, saw_5, saw_6, saw_9, saw_10, saw_11
```
10. Click OK.
11. Click the Prompts tab.

Create two prompts for Ledger and Accounting Period.
12. Click the Add icon > Column Prompts > "Ledger"."Ledger".
The New Prompt: Ledger dialog box appears.
13. Click Options on the New Prompt: Ledger dialog box.
14. Enter SQL Results in the Choice List Values field.
   A default query appears in the SQL statement box.
15. Replace the default query with the following query:

   ```sql
   SELECT "General Ledger - Journals Real Time".~- Ledger"~.Ledger Name" FROM "General Ledger - Journals Real Time" ORDER BY 1 ASC NULLS LAST FETCH FIRST 65001 ROWS ONLY
   ```
16. Enter Presentation Variable in the Set a variable field.
17. Enter p_ledger as the presentation variable.
18. Click OK.
   The New Prompt: Accounting_Period dialog box appears.
20. Click Options on the New Prompt: Accounting_Period dialog box.
21. Enter SQL Results in the Choice List Values field.
22. Replace the default query with the following query:

   ```sql
   SELECT "General Ledger - Journals Real Time"."Time"."Fiscal Period" s_2, SORTKEY("General Ledger - Journals Real Time"."Time"."Fiscal Period") s_3, "General Ledger - Journals Real Time".~- Ledger"~.Ledger Name" s_1 FROM "General Ledger - Journals Real Time" where "General Ledger - Journals Real Time".~- Ledger"~.Ledger Name" in ('@{p_ledger}') ORDER BY 1,2 ASC NULLS LAST FETCH FIRST 65001 ROWS ONLY
   ```
23. Enter Presentation Variable in the Set a variable field.
24. Enter p_period as the presentation variable.
25. Click OK.
26. Click Add > Column Prompt > "Legal_Entity" . "Legal_Entity".
   The New Prompt: Legal_Entity dialog box appears.
27. Click Options on the New Prompt: Legal_Entity dialog box.
28. Enter SQL Results in the Choice List Values box.
29. Remove the default query and enter the following query:

   ```sql
   SELECT "General Ledger - Journals Real Time".~- Header Details"~.Journal Legal Entity" FROM "General Ledger - Journals Real Time" ORDER BY 1 ASC NULLS LAST FETCH FIRST 65001 ROWS ONLY
   ```
30. Enter Presentation Variable in the Set a variable field.
31. Enter p_legal_entity as the presentation variable.
32. Click OK.

Generating the Auxiliary Report for Mexico
After completing the prerequisites, perform the following steps to run the report. Select your ledger and accounting period every time you run the report.

2. Click Catalog.
3. Navigate and select the Mexico folder in My Folders.
4. Click Open to open the Balance Journals Detail report.
5. Specify the ledger and accounting period in the Ledger and Accounting Period fields.
6. Click OK.
The report appears in a tabular format.

Convert the Auxiliary Report for Mexico to an XML Format

To upload the Auxiliary Report for Mexico to the Tax Administration Services (SAT) website, you must first convert the report into an XML format.

To convert the report, perform the following steps:

1. Run the Auxiliary Report Mexico report in Oracle Business Intelligence Publisher
   Export the report to Microsoft Excel.
2. Click the Export option, select Data, and then select CSV Format.
3. On the Opening Balance Journals Details with Prompts dialog box, select the Open with option and click OK.
The report appears in Microsoft Excel.
4. Click the View tab.
5. Click Macros > Record Macros.
The Record Macros dialog box appears.
6. Click OK.
7. Click the View tab.
8. Click Macros > View Macros.
9. Click Edit on the Macros dialog box.
   Microsoft Visual Basic editor appears.
10. Replace the existing code with the following code:

```
Sub MakeXML()
   ' create an XML file from an Excel table
   Dim MyRow As Integer, MyCol As Integer, MyCol2 As Integer, Temp As String, YesNo As Variant, DefFolder As String
   Dim XMLFileName As String, XMLRecBuffer As String, XMLRec2Buffer As String, MyLF As String, RTC1 As Integer
   Dim RangeOne As String, RangeTwo As String, Tt As String, FldName(99) As String, CheckFlag As Integer, Arr
   Dim Version As String, RFC As String, Mes As String, Anio As String, TipoSolicitud As String, NumOrden As String
   Dim NumTramite As String, Sello As String, noCertificado As String, Certificado As String, lastRow As Long
   Dim XML As String, MidStr As String, Row As String, XML3 As String, XML4 As String, Pos As String, Pos2 As String

   MyLF = Chr(10) & Chr(13) ' a line feed command

   YesNo = MsgBox("This procedure requires the following data:") & MyLF _
   & "1 A filename for the XML file" & MyLF _
   & "2 Version Value" & MyLF _
   & "3 RFC Value" & MyLF _
   & "4 Mes Value" & MyLF _
   & "5 Anio Value" & MyLF _
   & "6 TipoSolicitud Value" & MyLF _
   & "7 NumOrden Value" & MyLF _
   & "8 NumTramite Value" & MyLF _
   & "9 Sello Value" & MyLF _
   & "10 noCertificado Value" & MyLF _
   & "11 Certificado Value" & MyLF _
& "Are you ready to proceed?", vbQuestion + vbYesNo, "MakeXML CiM")

If YesNo = vbNo Then
  Debug.Print "User aborted with 'No'"
  Exit Sub
End If

XMLFileName = FillSpaces(InputBox("1. Enter the name of the XML file:", "MakeXML CiM", "xi_xml_data"))
If Right(XMLFileName, 4) <> " xml" Then
    XMLFileName = XMLFileName & ".xml"
End If

If Len(Dir("C:\Mexico", vbDirectory)) = 0 Then
  MkDir "C:\Mexico"
End If

If Len(Dir("C:\Mexico\Auxiliary", vbDirectory)) = 0 Then
  MkDir "C:\Mexico\Auxiliary"
End If

DefFolder = ActiveWorkbook.Path
'c:\Mexico\Auxiliary"
'InputBox("2. Enter the location of the path for the output file" , "MakeXML CiM", "Enter the Path")
RangeOne = "A1:K1"
If MyRng(RangeOne, 1) <> MyRng(RangeOne, 2) Then
  MsgBox "Error: names must be on a single row" & MyLF & "Procedure STOPPED", vbOKOnly + vbCritical,
  "MakeXML CiM"
  Exit Sub
End If
MyRow = MyRng(RangeOne, 1)
For MyCol = MyRng(RangeOne, 3) To MyRng(RangeOne, 4)
  If Len(Cells(MyRow, MyCol).Value) = 0 Then
    MsgBox "Error: names range contains blank cell" & MyLF & "Procedure STOPPED", vbOKOnly + vbCritical,
    "MakeXML CiM"
    Exit Sub
End If
FldName(MyCol - MyRng(RangeOne, 3)) = FillSpaces(Cells(MyRow, MyCol).Value)
Next MyCol

'RangeTwo = InputBox("3. Enter the range of cells containing the data table:", "MakeXML CiM", "A2:I2")

RangeTwo = "A2:K" & lastRow
If MyRng(RangeOne, 4) - MyRng(RangeOne, 3) <> MyRng(RangeTwo, 4) - MyRng(RangeTwo, 3) Then
    MsgBox "Error: number of field names <> data columns" & MyLF & "Procedure STOPPED", vbOKOnly + vbCritical,
    "MakeXML CiM"
    Exit Sub
End If
RTCl = MyRng(RangeTwo, 3)

Version = InputBox("2. Enter the Version Value:", "MakeXML CiM", "1.1")
Version = "Version=" & Chr(34) & Version & Chr(34)

RFC = InputBox("3. Enter the RFC Value:", "MakeXML CiM", "RFC Value")
RFC = "RFC=" & Chr(34) & RFC & Chr(34)

Mes = InputBox("4. Enter the Mes Value:", "MakeXML CiM", "Mes Value")
Mes = "Mes=" & Chr(34) & Mes & Chr(34)

Anio = InputBox("5. Enter the Anio Value:", "MakeXML CiM", "Anio Value")
Anio = "Anio=" & Chr(34) & Anio & Chr(34)

TipoSolicitud = InputBox("6. Enter the TipoSolicitud Value:", "MakeXML CiM", "TipoSolicitud Value")
TipoSolicitud = "TipoSolicitud=" & Chr(34) & TipoSolicitud & Chr(34)
NumOrden = InputBox("7. Enter the NumOrden Value:", "MakeXML CiM", "NumOrden Value")
NumOrden = "NumOrden=" & Chr(34) & NumOrden & Chr(34)

NumTramite = InputBox("8. Enter the NumTramite Value:", "MakeXML CiM", "NumTramite Value")
NumTramite = "NumTramite=" & Chr(34) & NumTramite & Chr(34)

Sello = InputBox("9. Enter the Sello Value:", "MakeXML CiM", "Sello Value")
Sello = "Sello=" & Chr(34) & Sello & Chr(34)

noCertificado = InputBox("10. Enter the Certificado Number Value:", "MakeXML CiM", "noCertificado Value")
noCertificado = "noCertificado=" & Chr(34) & noCertificado & Chr(34)

Certificado = InputBox("11. Enter the Certificado Value:", "MakeXML CiM", "Certificado Value")
Certificado = "Certificado=" & Chr(34) & Certificado & Chr(34)

Arr = Array(Version, RFC, Mes, Anio, TipoSolicitud, NumOrden, NumTramite, Sello, noCertificado, Certificado)

If InStr(1, XMLFileName, ":") = 0 Then
    XMLFileName = DefFolder & "\" & XMLFileName
End If

XMLRecBuffer = " <Cuenta 
CheckFlag = 0

'XML3 = "<AuxiliarCtas xmlns:xsi=" & Chr(34) & "http://www.w3.org/2001/XMLSchema-instance" & Chr(34) & " xmlns=" & Chr(34) & "http://www.sat.gob.mx/esquemas/ContabilidadE/1_1/AuxiliarCtas xsd" & Chr(34) & " Version=" & Chr(34) & " RFC=" & Chr(34) & " Mes=" & Chr(34) & " Anio=" & Chr(34) & " TipoSolicitud=" & Chr(34) & " NumOrden=" & Chr(34) & " NumTramite=" & Chr(34) & " Sello=" & Chr(34) & " noCertificado=" & Chr(34) & " Certificado=">

XML3 = "<AuxiliarCtas xmlns:xsi=" & Chr(34) & "http://www.w3.org/2001/XMLSchema-instance" & Chr(34) & " xmlns=" & Chr(34) & "http://www.sat.gob.mx/esquemas/ContabilidadE/1_1/AuxiliarCtas xsd" & Chr(34) & " Version=" & Chr(34) & " RFC=" & Chr(34) & " Mes=" & Chr(34) & " Anio=" & Chr(34) & " TipoSolicitud=" & Chr(34) & " NumOrden=" & Chr(34) & " NumTramite=" & Chr(34) & " Sello=" & Chr(34) & " noCertificado=" & Chr(34) & " Certificado=>

Row = ""

Open XMLFileName For Output As #1

For I = 0 To 9
    Pos = InStr(1, Arr(I), Chr(34))
    Pos2 = InStrRev(Arr(I), Chr(34), -1)
    Pos2 = Pos2 - Pos
    MidStr = Mid(Arr(I), (Pos + 1), (Pos2 - 1))
    If MidStr <> "" Then
        Row = Row & " " & MidStr
    End If
Next I

XML4 = XML4 & Row

XML3 = XML4 & ">

'Open XMLFileName For Output As #1
Print #1, "<?xml version=" & Chr(34) & "1.0" & Chr(34) & " encoding=" & Chr(34) & "UTF-8" & Chr(34) & "?>"
Print #1, XML3
For MyRow = MyRng(RangeTwo, 1) To MyRng(RangeTwo, 2)
    For MyCol = RTC1 To MyRng(RangeTwo, 4)
        If MyCol = 7 And CheckFlag = 0 Then
            Print #1, XMLRecBuffer & "">
            CheckFlag = 1
        End If
        If MyCol = 7 Then
            XMLRec2Buffer = " <DetalleAux "
            For MyCol2 = MyCol To MyRng(RangeTwo, 4)
                If RemoveAmpersands(FormChk(MyRow, MyCol2)) <> "" Then
                    XMLRec2Buffer = XMLRec2Buffer & " " & FldName(MyCol2 - 1) & "=" & Chr(34) & RemoveAmpersands(FormChk(MyRow, MyCol2)) & Chr(34)
                ElseIf FldName(MyCol2 - 1) = "Debe" Or FldName(MyCol2 - 1) = "Haber" And
                    RemoveAmpersands(FormChk(MyRow, MyCol2)) = "" Then
                    XMLRec2Buffer = XMLRec2Buffer & " " & FldName(MyCol2 - 1) & "=" & Chr(34) & "0" & Chr(34)
                End If
            Next MyCol2
            Print #1, XMLRec2Buffer & "/">
        End If
        ' the next line uses the FormChk function to format dates and numbers
        ' the next line does not apply any formatting
        Print #1, "<" & FldName(MyCol - RTC1) & ">" & RemoveAmpersands(Cells(MyRow, MyCol).Value) & "/" & FldName(MyCol - RTC1) & ">
    Next MyCol
    If CheckFlag = 0 Then
        If RemoveAmpersands(FormChk(MyRow, MyCol)) <> "" Then
            If FldName(MyCol - RTC1) = "Debe" Or FldName(MyCol - RTC1) = "Haber" Then
                XMLRecBuffer = XMLRecBuffer & " " & FldName(MyCol - RTC1) & "=" & Chr(34) & "0" & Chr(34)
            ElseIf FldName(MyCol - RTC1) = "NumCta" Then
                XMLRecBuffer = XMLRecBuffer & " " & FldName(MyCol - RTC1) & "=" & Chr(34) & RemoveAmpersands(FormChk(MyRow, MyCol + 1)) & Chr(34)
            Else
                XMLRecBuffer = XMLRecBuffer & " " & FldName(MyCol - RTC1) & "=" & Chr(34) & RemoveAmpersands(FormChk(MyRow, MyCol, MyCol + 1)) & Chr(34)
            End If
        End If
       ElseIf FldName(MyCol - RTC1) = "DesCta" Then
            XMLRecBuffer = XMLRecBuffer & " " & FldName(MyCol - RTC1) & "=" & Chr(34) & RemoveAmpersands(FormChk(MyRow, MyCol, MyCol + 1)) & Chr(34)
        End If
    End If
    Next MyRow
Print #1, "/</AuxiliarCtas>
Close #1
MsgBox XMLFileName & " created." & MyLF & "Process finished", vbOKOnly + vbInformation, "MakeXML CiM"
Debug.Print XMLFileName & " saved"
End Sub

Function MyRng(MyRangeAsText As String, MyItem As Integer) As Integer
' analyse a range, where MyItem represents 1=TR, 2=BR, 3=LHC, 4=RHC

Dim UserRange As Range
Set UserRange = Range(MyRangeAsText)
Select Case MyItem
Case 1
    MyRng = UserRange.Row
Case 2
Case 3
    MyRng = UserRange.Column
Case 4
End Select
Exit Function
End Function

Function FillSpaces(AnyStr As String) As String
' remove any spaces and replace with underscore character
Dim MyPos As Integer
MyPos = InStr(1, AnyStr, " ")
Do While MyPos > 0
    Mid(AnyStr, MyPos, 1) = "_"
    MyPos = InStr(1, AnyStr, " ")
Loop
FillSpaces = AnyStr
End Function

Function FormChk(RowNum As Integer, ColNum As Integer) As String
' formats numeric and date cell values to comma 000's and DD MMM YY
FormChk = Cells(RowNum, ColNum).Value
' If IsNumeric(Cells(RowNum, ColNum).Value) Then
'    FormChk = Format(Cells(RowNum, ColNum).Value, ",###0 ;(#,##0)
'    End If
If IsDate(Cells(RowNum, ColNum).Value) Then
    FormChk = Format(Cells(RowNum, ColNum).Value, "yyyy-mm-dd")
End If
End Function

Function RemoveAmpersands(AnyStr As String) As String
' replace Ampersands (&) with plus symbols (+)
Dim MyPos As Integer
MyPos = InStr(1, AnyStr, "&")
Do While MyPos > 0
    Mid(AnyStr, MyPos, 1) = "+
    MyPos = InStr(1, AnyStr, "&")
Loop
RemoveAmpersands = AnyStr
End Function

11. Run the macro.

The MakeXML CiM dialog box appears containing instructions to provide several details in a series of dialog boxes.

12. Click Yes and proceed with information entry on each dialog box as they appear one after the other. Enter the following information:
   - Name of the output file
   - Location to save the file
13. Verify the location where the output files will be saved and click OK.

Open the XML report that is saved at location you specified.

FAQs for General Ledger Reporting

How do parent accounts and subaccounts appear in the Mexico reports?

When you have a combination of account and subaccount, the SubCtaDe field displays the immediate natural account preceding the subaccount and not the original parent account.

For example, the following table displays the natural accounts (parent and child accounts) and the associated subaccounts.

<table>
<thead>
<tr>
<th>Natural Account - Parent</th>
<th>Natural Account - Child</th>
<th>Subaccount</th>
<th>SubCtaDe field displays</th>
</tr>
</thead>
<tbody>
<tr>
<td>100</td>
<td>10001</td>
<td>100</td>
<td>100 10001</td>
</tr>
<tr>
<td>10002</td>
<td>001</td>
<td>10002 001</td>
<td></td>
</tr>
<tr>
<td>10002</td>
<td>002</td>
<td>10002 002</td>
<td></td>
</tr>
</tbody>
</table>

The parent account for the natural accounts - child 10001 and 10002 is 100. However, subaccount 001 is 10002 and not 100. When the parent account has a combination of segments (account and subaccount), the account preceding the subaccount appears on the report.
Why doesn't my report display details of foreign fiscal documents?

Information on foreign fiscal documents (CompExt) appears only for foreign invoices.

Why is my RFC not appearing on the Mexican reports?

For your RFC (Taxpayer Identification Registry) to appear at the:

- Header level of a report, specify it at the legal entity level while creating your legal entity.
- National fiscal documents of type CFDI (CompNal) level and payment levels, specify it at the supplier level.
2 Financials for Brazil

Fiscal Document Generation

Fiscal Document Generation

A fiscal document is generated to represent sale of goods or services and movement of goods or assets from one location to another. A fiscal document provides all relevant details of a transaction, including applicable taxes and associated fiscal attributes.

A fiscal document is created in an XML format and is validated by the tax authorities before it is sent to the customers. It can also be sent in a paper format, called DANFE, along with the goods.

You can void or cancel a fiscal document within a specified time period. You can also generate an alternate document in contingency mode, in case there is no response from the tax authority.

You can generate a fiscal document either from the Receivables workflow or Shipment workflow. A receivables invoice is used to support the generation of a fiscal document for sale of goods, services, or both. From Shipment, you can generate fiscal documents for internal material transfers and return to supplier transactions.

You can generate a fiscal document only for transactions that are associated with a business unit operating in Brazil.

To correctly generate the fiscal document, ensure the Enable Fiscal Document Processing check box is enabled on the Localization System Options page. This allows you to capture the appropriate fiscal attributes.

After the fiscal document is generated, it can be extracted in an extract file. You can use third party software to interface the document to the tax authority portal and capture back the approval or rejection status. Alternatively, you can manually upload the fiscal document to the tax authority portal and update the return status in the Oracle Fusion application.

A service fiscal document follows a similar flow but it should be approved by a city tax authority, since the service taxes are collected by cities. For service invoices, separate fiscal documents are generated for each invoice line and handled individually. Similarly, mixed invoices with goods and service lines will generate one mixed fiscal document that is submitted to the state or federal tax authority and one service fiscal document for each service line that is submitted to the city tax authority.

Fiscal Document Generation Statuses

A fiscal document goes through different stages in its life cycle and different statuses are used to track them.

Use the Manage Fiscal Document Generation page to search and track the status of your fiscal document. This page can be accessed from both the Receivables workflow and Shipment workflow.

Note: You need the Fiscal Document Generation duty role to search and track the fiscal document.

The following table lists the different statuses that can be assigned to a fiscal document:
<table>
<thead>
<tr>
<th>Status</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transaction Entered</td>
<td>When transaction entry is complete.</td>
</tr>
<tr>
<td>Scheduled</td>
<td>When fiscal attributes are entered and the transaction is ready for fiscal document generation.</td>
</tr>
<tr>
<td>In Process</td>
<td>When a record is locked for processing. It is used to restrict changes to the fiscal attributes.</td>
</tr>
<tr>
<td>Validation Errors</td>
<td>When errors are identified in the fiscal attribute details.</td>
</tr>
<tr>
<td>Generated</td>
<td>When the fiscal attribute validation is successful and fiscal document number is allocated.</td>
</tr>
<tr>
<td>Generated - Contingency</td>
<td>When the fiscal document is generated in contingency mode.</td>
</tr>
<tr>
<td>Sent</td>
<td>When a fiscal document is made available to the third-party application.</td>
</tr>
<tr>
<td>Approved</td>
<td>When a fiscal document is approved by the tax authority.</td>
</tr>
<tr>
<td>Approval Errors</td>
<td>When a fiscal document is rejected by the tax authority because of errors.</td>
</tr>
<tr>
<td>Marked for Cancel</td>
<td>When a fiscal document is marked for cancellation.</td>
</tr>
<tr>
<td>Marked for Void</td>
<td>When a fiscal document is marked for void.</td>
</tr>
<tr>
<td>Canceled</td>
<td>When the tax authority approves canceling of a fiscal document.</td>
</tr>
<tr>
<td>Voided</td>
<td>When the tax authority approves voiding of a fiscal document.</td>
</tr>
<tr>
<td>Upload Failure</td>
<td>When the third party application reports upload failure to the tax authority site.</td>
</tr>
<tr>
<td>Approved with Corrections</td>
<td>When the tax authority approved a fiscal document with certain corrections to the tax amounts.</td>
</tr>
<tr>
<td>Pending Return</td>
<td>Status returned by third party application when there is no update from the tax authority.</td>
</tr>
<tr>
<td>Rejected</td>
<td>When the tax authority rejects the fiscal document.</td>
</tr>
</tbody>
</table>

The tax authority can return the fiscal document approval, or can mark the validation errors or can reject the fiscal document. If the partner informs there are communication issues with tax authority, the fiscal document can be generated in contingency mode so goods can be shipped. Besides that, if necessary a fiscal document can be canceled after receiving an approval from the tax authority or it can be voided before it is sent to the tax authority.

All these statuses are effectively managed and tracked through the Manage Fiscal Document Generation page.

When a fiscal document represents sale of goods and services through a single transaction, involving reporting and approval from different tax authorities, a dynamic approval process is built into the application where the approval from different tax authorities is managed in a queue model, in a synchronous mode.
How You Cancel or Void a Fiscal Document

You can void a fiscal document if you want to report to the tax authority that the fiscal document number will not be used. However, this can be done only after the fiscal document is generated and before it is approved by the tax authority. Use the **Void Fiscal Document** button on the Manage Fiscal Document Generation page to void a fiscal document.

When a fiscal document is validated and approved by the tax authority, but the goods or services are no longer intended to be provided or shipped, you can cancel the fiscal document. Use the **Cancel Fiscal Document** button on the Manage Fiscal Document Generation page to cancel a fiscal document.

Provide a valid reason to void or cancel a fiscal document. The reason must be notified to the tax authority. A fiscal document can be considered as canceled or voided only after confirmation from the tax authority. When the tax authority does not approve the cancellation or voiding of a fiscal document, the status of the fiscal document is changed back to Approved or Generated.

**Note:** You can void or cancel a fiscal document within a defined time limit. The time limit within which you can cancel or void a fiscal document is specified by each tax authority. Use the Party Tax Profile page to set the time limit.

Fiscal Documents for Fixed Assets and Material Transfer

You need to generate a fiscal document when any material or assets move across different locations within an organization, even though it doesn’t involve any sale. When a fixed asset is transferred from one location to another, a receivables invoice is automatically created for supporting the creation of a fiscal document. The invoice captures all the transfer details of the asset and has a transaction type that doesn’t post to General Ledger or create open balances in Receivables.

To be able to create a fiscal document for asset transfer across different locations, ensure the:

- Global descriptive flexfields associated with the Asset Book for creating fiscal documents for asset transfers is enabled.
- Transaction Details section on the Create Fixed Assets Transfer Control page is updated. You can access the Create Fixed Assets Transfer Control page through the Manage Fiscal Document Generation Controls page. These transaction details are used for creating the Receivables invoice.
- Source and destination locations have legal reporting units assigned to them. The source and destination legal reporting units drive the need for creating a fiscal document. Use the Manage Asset Locations task to specify the legal reporting units.

When these conditions are met, a Receivables invoice is created with details of the fixed asset transfer. The invoice is then used to generate a fiscal document.

You can track the Receivables invoices that are created for each fixed asset transfer through the Manage Asset Transfers Requiring Fiscal Document task.

Similarly, when goods are moved from one warehouse to another, the fiscal document representing the internal material transfer is generated through the reference of the corresponding shipment.
How You Configure Setup Manager for Fiscal Document Generation

Use Oracle Financials Cloud to generate fiscal documents. You can create a fiscal document, get it validated by the tax authority, and send it to the customers. It is generated as an XML file and provides all relevant details of a transaction, including applicable taxes and associated fiscal attributes.

In the Oracle Fusion Functional Setup Manager, perform the following tasks to be able to generate fiscal documents:

- **Regional Localization**: Regional Localization for Brazil must be enabled within the feature offerings for Financials. Select Brazil as the Regional Localization in Financials features.

- **Localization System Options**: For every business unit operating in Brazil, the country field must be updated and the option for fiscal document processing must be enabled.

  Select Brazil as the Country and check the Enable Fiscal Document Processing check box on the Manage Localization System Options page. This allows you to:

  - Capture fiscal attributes for invoice and debit memo in Receivables and for internal material transfer shipments and return to supplier shipment in Shipments
  - Generate and manage fiscal documents.

- **Manage Asset Book**: Use the Manage Asset Book task to identify the assets within an asset book that require fiscal document processing.

  This set up also enables processing of fiscal document when a fixed asset belonging to an asset book is transferred.

- **Manage Fiscal Document Generation Controls**: This setup is used to specify various fiscal document generation controls, including default fiscal attributes. For fixed assets, this setup specifies the source and destination legal reporting units between which any transfer of fixed assets will require a fiscal document. It also provides the details of key attributes required to generate a receivables invoice that supports generation of a fiscal document.

- **Manage Asset Locations**: Use the Manage Asset Locations task to specify the legal reporting units that must be assigned to each location.

  Legal reporting units must be assigned to each location, so that transfer of assets across locations can identify the source and destination legal reporting units.

- **Manage Tax Authority Tax Profiles**: Use this task to classify a tax authority and to specify the time controls for performing various actions on a fiscal document like cancel, void, or generate in contingency.

- **Configure Taxes**: Specify or configure taxes for applying relevant taxes on transactions which support fiscal document generation. This setup includes usage of key tax determinants like transaction business category, product category, and product fiscal classification.

Import Fiscal Document Approval Information

You can import tax authority return information related to fiscal documents using the Fiscal Document Tax Authority Return Interface process. The Import Fiscal Document Approval Information process will read from the Tax Authority Return Interface tables, which can be populated using the Oracle Fusion Financials Utility web service. This is a part of the ERP Cloud Integration Framework.
Use the Load Interface File for Import Process or the Financial Utilities Service web service to load return information from the tax authority. Once data is loaded successfully, use the Import Fiscal Document Approval Information process to handle responses from the tax authority.

To access the template, complete the following steps:

1. Navigate to the File-Based Data Import for Oracle Financials Cloud guide.
2. In the Table of Contents, click File-Based Data Imports.
3. Click Import Fiscal Document Approval Information.
4. In the File Links section, click the link to the Excel template.

Follow these guidelines when preparing your data in the worksheet:

- Prepare the data for each interface table using the corresponding worksheet in this template.
- Refer to the bubble text on each column header either for detailed instructions on preparing the data in that column, or for a description of the data and data type that the column requires.
- Common tasks for preparing table data include setting up for data merge, and searching for internal identifiers.

Settings That Affect the Fiscal Document Approval Information Import Process

The Import Fiscal Document Attributes template contains an instructions tab, plus three tabs that represent the tables where the data is loaded:

<table>
<thead>
<tr>
<th>Spreadsheet Tab</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Instructions and CSV Generation</td>
<td>Contains instruction information about preparing and loading data, the format of the template, submitting the Import Fiscal Document Approval Information process.</td>
</tr>
<tr>
<td>Tax Authority Return</td>
<td>It is the parent table and contains retrieved information related to fiscal documents. (JG_FSCL_TAX_AUTH_RET_INT)</td>
</tr>
<tr>
<td>Tax Authority Tax Return</td>
<td>It is a child table and contains retrieved information related to taxes. Data in this sheet is linked to the parent entity sheet using Fiscal Document Key and Fiscal Document Event Code. (JG_FSCL_TAX_AUTH_TAXES_INT)</td>
</tr>
<tr>
<td>Tax Authority Message Return</td>
<td>It is a child table and contains retrieved information related to messages. Data in this sheet is linked to the parent entity sheet using Fiscal Document Key and Fiscal Document Event Code. (JG_FSCL_TAX_AUTH_MSG_INT)</td>
</tr>
</tbody>
</table>

How Fiscal Document Approval Information Import Data Is Processed

Loading the Data

After you finish preparing the data, you must load the data. To load the data:

1. On the Instructions and CSV Generation tab of the template, click the Generate CSV File button to generate a Zip file containing one or more CSV files.
2. From Scheduled Process, use Load Interface File for Import and select Import Fiscal Document Approval Information as the import process.
3. In Data File, select Upload a new file and then select the Zip file you created.

Importing the Loaded Data
To submit the Import Fiscal Document Approval Information process:

1. Navigate to the Scheduled Processes page.
2. Click **Schedule New Process** in the Search Results table.
3. Select the **Import Fiscal Document Approval Information** process and click **OK**.
4. Enter the input parameters as needed:
5. Submit the process.
7. If the Import Fiscal Document Approval Information process ends in error or warning, review the log file for details about the rows that caused the failure.

Fiscal Document Capture

Overview of Tax Processing for Fiscal Document Capture

In Brazil, a fiscal document is generated for every sale or shipment involving goods or services. The supplier creates this document, gets it validated by the tax authority and sends it to the customer. It is generated as an XML file or as a physical document and provides complete details of the transaction along with applicable taxes.

You can use the fiscal document capture feature to support processing of fiscal documents received from suppliers. The documents can be received either manually or in an XML format.

You can use fiscal document capture to support the processing of fiscal documents received from suppliers or third parties. You can enter the documents either manually or import them. Several validations are performed like comparison with source documents, verification of taxes against the tax setup, confirmation of goods received, and so on. After the validations, the corresponding receipts and Payables invoice are automatically created on the basis of the information from the fiscal document.

Complementary fiscal documents, which are used to record corrections in quantity, price, or taxes are also handled by fiscal document capture. Similarly, freight fiscal documents covering freight charges against multiple deliveries are also supported.

How Taxes on Fiscal Documents Are Calculated

Fiscal documents issued by suppliers are validated by the tax authority. So, taxes applied on it are treated as source of truth for accounting and reporting purposes. However, during fiscal document capture and processing, taxes are additionally calculated as per tax setup, compared with the supplier notified taxes and a hold is placed if their difference is beyond tolerance limits. This hold prompts for either rectification of tax setup (if calculated taxes are incorrect) or for pursuing with the supplier to issue a complementary fiscal document (if supplier notified taxes are incorrect).

Use the Manage Configuration Owner Tax Options page to specify the tolerance limits for the difference between fiscal document taxes and calculated taxes. Use fiscal document capture as the application name.

On the Manage Fiscal Document page, the tax amount notified on the fiscal document is captured in the **Fiscal Document Tax Amount** field and the tax amount calculated according to tax setup is displayed in the **Tax Amount** field.

The following table provides the tax handling approach on an XML imported fiscal document for various scenarios involving these two attributes:
### Scenario | Tax Treatment
--- | ---
Tax is notified on the fiscal document and the same is applicable as per tax setup | Fiscal Document Tax Amount = <Notified Value>
Tax Amount= <Calculated Value>
Fiscal document goes on hold if their difference is beyond tolerance limit.

Tax is notified on the fiscal document, but it is not applicable as per tax setup | Fiscal Document Tax Amount = <Notified Value>
Tax Amount= 0.00
Fiscal document goes on hold.

Tax is not notified on the fiscal document, but it is applicable as per tax setup | Fiscal Document Tax Amount = 0.00
Tax Amount= <Calculated Value>
Fiscal document goes on hold.

Updates are made to the calculated tax amount | Fiscal Document Tax Amount = <Notified Value>
Tax Amount= <Updated Value>
Fiscal document goes on hold if their difference is beyond tolerance limit.

Manual tax line is created | Fiscal Document Tax Amount = 0.00
Tax Amount= <Input Value>
Fiscal document goes on hold.

If a fiscal document is received in a physical format, then it is manually entered through the Manage Fiscal Documents page.

When you click the **Calculate Tax** or **Validate Fiscal Document** buttons, taxes are calculated according to the tax setup. Both the Fiscal Document Tax Amount and Tax Amount attributes display the calculated value, you can review and correct fiscal document tax amount, if required.

You cannot update the tax information on the fiscal document when the status is **Completed Prevalidation**.

Irrespective of the mode of fiscal document creation, only the taxes captured into Fiscal Document Tax Amount are processed to downstream transactions.

### How Taxes on Complementary Fiscal Documents Are Calculated

If there is any discrepancy in the fiscal document sent by supplier on any aspects relating to price, quantity or tax, then a complementary fiscal document is issued by the supplier for rectifying the same. It is captured on the Manage Fiscal Document page as done in the case of regular fiscal document.

The tax amount notified on the fiscal document is captured in the Fiscal Document Tax Amount attribute and the amount calculated as per the tax setup is captured in the Tax Amount attribute. Tax treatment for different types of imported complementary fiscal documents and handling of values within these two attributes is given in the following table.
When complementary fiscal documents involve price or tax corrections, the tax amount notified in the fiscal document is also taken as the calculated tax amount, as the transaction information is not sufficient for calculating tax. When such fiscal documents are received in physical format, you need to enter the tax details manually.

### Import Inbound Fiscal Documents

Use the Import Inbound Fiscal Document Attributes Template to populate your Inbound Fiscal Document Attributes and upload them into Oracle Fusion Applications. Prepare the required Inbound Fiscal Document Attributes offline in the applicable spreadsheet templates. You do not need to access any Oracle Fusion Applications while creating the spreadsheet. The template contains an instruction sheet to help guide you through the process of entering the required information.

You can import Inbound Fiscal Documents from other systems using the Import Inbound Fiscal Document Attributes process. Use the Import Inbound Fiscal Document Attributes process to import fiscal document attributes that are related to Payables Transactions, therefore inbound fiscal documents.

To access the template, complete the following steps:

1. Navigate to the File-Based Data Import for Oracle Financials Cloud guide.
2. In the Table of Contents, click **File-Based Data Imports**.
3. Click **Inbound Fiscal Document Import**.
4. In the File Links section, click the link to the Excel template.

Follow these guidelines when preparing your data in the worksheet:

- Enter the required information for each column. Refer to the tool tips on each column header for detailed instructions.
- Do not change the order of the columns in the template.
- You can hide or skip the columns you do not use, but do not delete them.

### Settings That Affect the Inbound Fiscal Document Attributes Import Process

The Import Inbound Fiscal Document Attributes template contains an instructions tab, plus one tab that represent the table where the data is loaded:
Spreadsheet Tab | Description
--- | ---
Instructions and CSV Generation | Contains instruction information about preparing and loading data, the format of the template, submitting the Import Outbound Fiscal Document Attributes process, and correcting import errors.

Fiscal Attribute Headers (JG_FSCL_HDRS_ATTRB_INT) | Captures Fiscal Document Header data from which Fiscal Documents headers are created after successful import. Fiscal Document header is created and tied to a Receivables or Payables Transaction.

Fiscal Attribute Header Details (JG_FSCL_HDR_DTLS_ATTRB_INT) | Captures the Fiscal Document Header Details data that you intend to assign to imported transactions. Data in this sheet is linked to the parent entity sheet Fiscal Attribute Headers using Document Id.

How Inbound Fiscal Document Attributes Import Data Is Processed

### Loading the Data

After you finish preparing the data, you must load the data. To load the data:

1. On the Instructions and CSV Generation tab of the template, click the **Generate CSV File** button to generate a Zip file containing one or more CSV files.
2. From Scheduled Process, use Load Interface File for Import and select **Import Inbound Fiscal Document Attributes** as the import process.
3. In Data File, select **Upload a new file** and then select the Zip file you created.

### Importing the Loaded Data

After you successfully load your data, you must submit the AutoInvoice processes to import the data into the application tables and create the transactions.

- Use the Import Payables Invoices process to create the Payables transactions
- Use the process Import Inbound Fiscal Document Attributes to create the Inbound Fiscal Document Attributes related to the Payables transactions

For more information on the Payables Invoice Import Interface process, refer to Oracle Enterprise Repository for Oracle Fusion Applications.

To submit the Import Inbound Fiscal Document Attributes process:

1. Navigate to the Invoices work area under Payables.
2. Click the **Import Inbound Fiscal Document Attributes** link in the Tasks section.
3. Enter the input parameters as needed:

<table>
<thead>
<tr>
<th>Input Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Batch Name</td>
<td>The batch name used in the Load File for Import Process</td>
</tr>
<tr>
<td>From Transaction Number / To Transaction Number</td>
<td>The range of transactions to be processed</td>
</tr>
<tr>
<td>From Date / To Date</td>
<td>The range of documents in between those dates to be processed</td>
</tr>
</tbody>
</table>

4. Submit the process.
If the Import Inbound Fiscal Document Attributes process ends in error or warning, review the log file for details about the rows that caused the failure.

To correct import errors:

1. Navigate to the Invoices work area under Payables.
2. In the Task section, click Correct Import Inbound Fiscal Document Attributes Errors. This will download a spreadsheet with the name CorrectInterfaceTransaction.xlsx.
3. Open the spreadsheet CorrectInterfaceTransaction.xlsx.
4. Enter the login details.
5. Review and correct the import errors in the spreadsheet.
6. After all incorrect rows are corrected, resubmit the process by clicking the Save and Submit Import Inbound Fiscal Document Attributes button.
7. Repeat the submit and error correction steps in this section until all rows are imported successfully and the transactions are created.

**Transaction Taxes**

**Value Addition During Tax Calculation**

Certain taxes in Brazil like ICMS-ST require you to estimate the final price of the product for evaluating the tax amount on a transaction. You can estimate the final price by applying a value addition percentage, as notified by the tax authority, on the transaction amount. Oracle Fusion Tax allows you to configure calculation of value addition percentage and tax through the taxable basis formula.

In the taxable basis formula, if the country associated with the tax regime is Brazil, then an option is enabled for specifying value addition information. Different value addition percentages can be configured based on the following transaction parameters:

- Ship-from geography
- Ship-to geography
- Product fiscal classification
- Transaction business category
- Intended use

You can specify the order of evaluation for these transaction parameters.

You can also use base rate modifier as a generic value addition option. However, the taxable basis formula provides better control and flexibility as you can specify the required values through a single taxable basis formula, on the basis of various transaction parameters.

**Price Thresholds During Tax Calculation**

Certain taxes in Brazil require applying of notified thresholds on prices of items quoted on a transaction. You can configure taxable basis formula in Oracle Fusion Tax to configure handling of price thresholds for tax calculation.
In the taxable basis formula, if the country associated with the tax regime is Brazil, then an option is enabled for specifying the price threshold information. Use the following transaction parameters to configure the taxes:

- Ship-from geography
- Ship-to geography
- Product fiscal classification
- Transaction business category
- Intended use

You can specify the order of evaluation for these transaction parameters.

You can also define price threshold values through:

- Fixed price: If the fixed price option is set, then the specified price is used as item price for deriving the taxable basis amount for the transaction line.
- Minimum or maximum threshold options: If minimum or maximum thresholds option is used, then the item price is compared against the given range of values and appropriate value is considered if it goes beyond the given range.

For example, if the item price on a transaction is quoted as 28 USD and the minimum threshold value is set as 32 USD, then the minimum threshold value gets applied (that is, 32 USD, instead of 28 USD) for calculating the taxable basis amount. However, if the item price is quoted as 48 USD and the maximum threshold value is set as 45 USD, then the item price is set at the maximum specified value (that is, 45 USD, instead of 48 USD).

You can define price thresholds with minimum and maximum values at the tax or jurisdiction level using the threshold basis as Line and type as Unit price. However, during the evaluation process, values notified in the taxable basis formula will always take first precedence. Also, handling of minimum threshold value derived from the threshold controls of tax or jurisdiction is different from the approach used when it is derived from taxable basis formula. In this case, if the item price is less than the specified minimum threshold value, then it is considered as 0.00 USD while calculating the taxable basis amount.

**Charges During Tax Calculation**

Certain taxes in Brazil require inclusion of charges while calculating taxable basis value of a transaction line. Oracle Fusion Tax allows you to handle charges for tax calculation through taxable basis formula. If the taxable basis type within a taxable basis formula is specified as Line amount, then you can add freight, insurance, packing charges, miscellaneous, and subtract commercial discount on the transaction line value.

If a transaction line is categorized into any of the following charge types: freight, insurance, miscellaneous, packing charges, or commercial discount, and if the taxable basis formula of a tax is configured to consider these values during tax calculation, then the corresponding allocated values from these lines (to the item lines) are added or subtracted while calculating the taxable basis value of that tax.

For example, the following table lists the line amount for two products along with some charges.

<table>
<thead>
<tr>
<th>Line</th>
<th>Description</th>
<th>Amount</th>
<th>Allocation</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Item A</td>
<td>2800</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Item B</td>
<td>1000</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Freight</td>
<td>100</td>
<td>Freight for item A is 60 and item B is 40</td>
</tr>
</tbody>
</table>
If IPI tax is applicable on item A and taxable basis formula associated with it has the options to add allocated freight and subtract commercial discount, then the taxable basis amount for transaction line 1 is 2,840 USD.

The following table gives the breakup of the taxable amount.

<table>
<thead>
<tr>
<th>Component</th>
<th>Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transaction line value</td>
<td>2800</td>
</tr>
<tr>
<td>(add) Allocated freight</td>
<td>60</td>
</tr>
<tr>
<td>(subtract) Commercial discount</td>
<td>20</td>
</tr>
<tr>
<td>Taxable Basis</td>
<td>2840</td>
</tr>
</tbody>
</table>

Differential Taxes for Brazil

In Brazil, differential tax is applicable when goods are procured from a different state at a lower tax rate when they can be sourced from within the state. Along with the regular tax, difference between intra-state and inter-state tax rate is additionally levied as differential tax on the customer procuring the goods. This tax becomes payable in the state where the goods are received.

For example, consider an organization located in location A that procures an item from a supplier located in location B. ICMS tax is applicable on the transaction. The tax rate is 18% if it is sourced from within the state (intra-state rate) and is 12% if sourced from outside the state (inter-state rate).

The following table provides details of the ICMS tax that is applicable for this transaction.

<table>
<thead>
<tr>
<th>Tax Details</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transaction amount</td>
<td>1000 USD</td>
</tr>
<tr>
<td>Tax Rate (inter-state)</td>
<td>12%</td>
</tr>
<tr>
<td>Tax amount</td>
<td>1000 * 12% = 120 USD</td>
</tr>
</tbody>
</table>

The following table provides details of the differential tax that is applicable to the transaction:

<table>
<thead>
<tr>
<th>Tax Details</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transaction amount</td>
<td>1000 USD</td>
</tr>
</tbody>
</table>
### Tax Details

<table>
<thead>
<tr>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Differential Rate</td>
<td>18% (−) 12% = 6%</td>
</tr>
<tr>
<td>Tax amount</td>
<td>1000 * 6% = 60 USD</td>
</tr>
</tbody>
</table>

The total tax payable is 180 (120+60) USD.

Consider the following points when configuring ICMS differential tax in Oracle Fusion Tax:

- Generally ICMS (differential) tax is not notified in the fiscal document sent by supplier. It must be assessed and paid by the organization procuring the goods or services from a different state. Therefore, configure it as self-assessed tax.
- To apply this tax as self-assessed, tax registration party must be configured to derive Ship-to Party or Bill-to Party. Further, tax registration record associated with the legal reporting unit must be marked as self-assessed.
- Tax rate percentage of this tax is a derived value and is the difference between intra-state and inter-state ICMS tax rates. This result is achieved through configuration of tax calculation formula:
  - ICMS tax would use inter-state tax rate percentage for calculating the tax amount. ICMS (differential) tax must be configured to derive the corresponding intra-state tax rate.
  - Tax calculation formula associated with ICMS (differential) must have compounding rule for subtracting the ICMS tax from its tax amount.
  - On processing the tax calculation formula, ICMS (differential) will result in a tax amount equal to the difference between intra-state and inter-state tax rates.
- ICMS (differential) is to be calculated along with ICMS tax. So, the tax applicability conditions for both these taxes must match. In addition to it, ICMS (differential) must have rule conditions to allow its applicability only on purchase transactions and on specific states, if applicable.
- ICMS (differential) involves compounding on ICMS tax. So the compounding precedence specified on the respective tax regimes or taxes must support this, therefore, the precedence number for ICMS must be less than ICMS (differential).
- ICMS (differential) tax is not applicable if the intra-state tax rate is less than the inter-state tax rate. This condition is inherently managed by the tax calculation logic, tax is not applied on the transaction if the differential amount between the compounded taxes results in a negative value.

### Tax Substitutions

Tax substitution concept is widely followed in countries such as Brazil. It refers to transferring the responsibility for paying taxes that become applicable at various stages within the supply chain, to one of the parties involved therein. In summary, one party within the supply chain (generally the producer) pays the entire tax that becomes applicable till the material reaches the user.

An organization located in location A sells an item to a customer located in the same state. As per the requirement, ICMS tax is applicable at 18% and the onus of tax substitution is on the original supplier, with a specified value addition of 40% (based on item, nature of transaction and other criteria).

Required tax treatment in the context of this example is:
ICMS-ST
Transaction Line amount 10,000 USD
Value Addition Percentage 40%
Net transaction line amount 10,000 * 1.40 = 14,000 USD
Base ICMS-ST Tax amount (@ 18%) 14,000 * 18% = 2,520 USD
Less: ICMS Tax (@ 18%) 10,000 * 18% = 1,800 USD
ICMS-ST amount 2,520 - 1,800 = 720 USD

Tax configuration for ICMS-ST:

<table>
<thead>
<tr>
<th>Tax Configuration</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tax</td>
<td>ICMS-ST is applied in addition to the regular tax. So, it must be configured as a separate tax. This is to be calculated on the net value addition that accrues within the supply chain, over the base transaction. So, it is to be configured similar to a differential tax.</td>
</tr>
<tr>
<td>Taxable Basis Formula</td>
<td>Taxable basis formula should include value addition configuration. Value addition conditions should match with the applicability criteria of the tax.</td>
</tr>
<tr>
<td>Tax Calculation Formula</td>
<td>Tax calculation formula must be defined for compounding on ICMS tax, with the compounding rule set to Subtract.</td>
</tr>
</tbody>
</table>

Tax calculation processing for ICMS-ST based on this setup is as follows:

<table>
<thead>
<tr>
<th>Tax Details</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Taxable Basis Amount (after applying value addition)</td>
<td>10,000 * 1.40 = 14,000 USD</td>
</tr>
<tr>
<td>Calculated Tax Amount (before compounding)</td>
<td>14,000 * 18% = 2,520 USD</td>
</tr>
<tr>
<td>Less: ICMS Tax (as per compounding rule)</td>
<td>1,800 USD</td>
</tr>
<tr>
<td>Calculated Tax Amount (after compounding)</td>
<td>2,520 - 1,800 = 720 USD</td>
</tr>
</tbody>
</table>
Consider the following points while configuring ICMS-ST taxes:

- ICMS-ST has three different variants such as:
  - ICMS-ST Forward: This amount is notified on the fiscal document, along with ICMS tax.
  - ICMS-ST Anticipated: This amount is not notified on the fiscal document. Receiver of the goods or services is responsible for assessing the tax and paying it to the tax authority.
  - ICMS-ST Backward: This tax is applicable for road transportation services availed through a third party transportation company. Party contracting for the transportation services (buyer or supplier) is responsible for assessing the tax and paying it to the tax authority.

- In situations involving the Forward approach, tax should be configured for application on both purchase and sales events. In case of situations involving the Anticipated or Backward approach, tax conditions should cover only purchase events and it should get applied as Self-assessed tax.

- To apply this tax as self-assessed, the tax registration party must be configured to derive Ship-to Party or Bill-to Party. Further, tax registration record associated with the Legal Reporting Unit should be marked as Self-assessed.

- Taxable basis amount for ICMS-ST is based on either estimated sale price (if notified by the tax authority) or a value addition percentage. If transactions exist with a combination of these criteria, then different taxable basis formulas should be defined with Price Thresholds and Value addition details. Rule conditions could be configured to pick the appropriate taxable basis formula.

- If taxable basis formula is based on price thresholds, then it should be configured with Fixed Price option. Also, the precedence levels should be appropriately marked for processing price thresholds or value addition, especially when the evaluating criterion is similar. As done in case of rule order evaluation, most commonly used transaction criteria should be set with least precedence numbers.

- ICMS-ST is calculated along with ICMS Tax. So, the tax applicability conditions for both these taxes must match. In addition, ICMS-ST should include criteria relating to Forward or Anticipated or Backward approach for processing specific treatment on this tax based on transaction details.

- ICMS-ST represents differential tax amount between what is legitimately payable by the party in the regular course of business and what could be the total tax that becomes payable by all the transacting parties within the supply chain. This value can be achieved through the configuration of tax calculation formula, with compounding rule for subtracting ICMS tax.

- Since ICMS-ST involves compounding on ICMS tax, the compounding precedence specified on the respective tax regimes or taxes must support it, the precedence number for ICMS must be less than ICMS-ST.

### Rapid Implementation to Configure Brazilian Taxes

You can use the rapid implementation spreadsheets to configure the basic tax setup, that is, regime to rate and tax rules for Brazil. However, in certain areas, some additional configuration is required. The following table provides details of the additional steps that need to be performed for some tasks.

<table>
<thead>
<tr>
<th>Task</th>
<th>Additional Steps</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tax Regime</td>
<td>Create compounding precedence</td>
<td>On certain transactions, IPI is compounded on ICMS. ICMS is also compounded on ICMS-ST or ICMS (Differential). So, appropriate compounding precedence must be set for each tax regime.</td>
</tr>
<tr>
<td>Task</td>
<td>Additional Steps</td>
<td>Notes</td>
</tr>
<tr>
<td>------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Taxes</td>
<td>Set the default applicability, default taxable basis formula and the default tax calculation formula</td>
<td>Taxes are created with the default applicability. They must be set as not applicable, if rules are configured for applicability. Similarly, standard taxable basis formula and tax calculation formula are used as default values for few taxes (like IPI, ICMS-ST) must be changed.</td>
</tr>
<tr>
<td>Tax Rates</td>
<td>Revise the rate type</td>
<td>If IPI tax is to be applied based on quantity instead of percentage, then the rate type attribute configured through rapid implementation requires manual correction.</td>
</tr>
<tr>
<td>Taxable Basis Formula</td>
<td>Create compounding and additional data setup</td>
<td>Taxable basis formula for ICMS tax requires compounding of IPI tax. Some taxes like ICMS-ST also require configuration of price thresholds or value additions.</td>
</tr>
<tr>
<td>Tax Calculation Formula</td>
<td>Create compounding</td>
<td>Tax calculation formula for taxes like ICMS (differential) and ICMS-ST require compounding on ICMS tax.</td>
</tr>
<tr>
<td>Tax Registrations</td>
<td>Mark self-assessment</td>
<td>ICMS (Differential) and ICMS-ST may be required to be calculated as self-assessed. Tax registration records will need correction.</td>
</tr>
<tr>
<td>Tax Rules</td>
<td>Update list of values</td>
<td>Few tax rules are based on list of values. All such values must be manually configured.</td>
</tr>
</tbody>
</table>

**Receivables**

**Sales Invoice and Customer Receipt Enhancements for Brazil**

To support the common business practices in Brazil, the payment collection process is enhanced to support transactions between suppliers, customers, and their banks. You can now automatically generate and electronically transmit collection documents to banks for collecting payments due from customers.

The processes are automated using electronic file transfers that transfer information from companies to banks and the return from banks to companies.

You can:

- Process receipt files from banks for the associated collection documents. Include taxes and short payments on collection documents submitted for Receivables invoices.
- Use city-specific calendars to identify local holidays and ensure due dates are accurately assigned, and late payment interest is correctly calculated and included in the collection documents for bank transfers.
- Send remittance collection documents to customer banks based on invoice payment terms.
Send remittance update collection documents for any updates, discounts, or protests to process corrections to files that are already sent.

Receive bank files with information on payments collected from customers, and create and apply receipts.

Create Receivables Invoices and Generate Remittance Batch

The following enhancements are available for generating a remittance batch:

- Create Receivables transactions and complete them by receiving final approval on the associated fiscal documents. Receivable invoices associated with approved fiscal documents are then available to be included in a remittance batch for collection.

- Use a remittance batch to send information to the customer’s bank for payment collection. The information sent to a bank includes instructions such as interest charges to be collected and any protest after due date. When generating a remittance batch, selection criteria can be specified to automatically or manually select the installments to include in the batch. Collection documents are created in Receivables for the installments. After creating collection documents to be sent to the bank, review the collection documents selected in the batch and remove any, if needed.

- Enter parameters during batch creation to limit selection of records or default information, such as the maximum quantity of documents per remittance batch, minimum or maximum amount for a document, or a minimum or maximum total amount for the remittance batch.

- Assign specific bank remittance formats to each bank. Once the remittance batch details have been reviewed, the remittance batch is generated base upon the assigned format and validated. The batch can be edited to correct errors and re-generated. A remittance batch can also be canceled before a bank return is done if needed.

Updates to Collection Documents

Use bank collection updates to provide additional directions to a bank for collection documents that are already sent in a remittance batch. Once the updates are entered, create a collection update remittance batch to send to a bank. Collection document updates can be created automatically based on certain actions or can be created manually as needed to process collection document updates.

Bank Returns and Receipts

Receive information from banks as a file that can be imported. Use the Import Bank Returns for Brazil program to import and validate the bank return details in the file and to upload and validate records that have been manually entered in a spreadsheet. A validation is performed against the associated collection documents and bank return records rejected by this process are shown in the Bank Return Import Report.

Rejected bank return records can be corrected and a Correct Bank Returns spreadsheet used to upload corrected information. The uploaded details are also validated by the same import process. After completion of import process, AR receipts are created automatically and can be applied using the standard Receivables processes.

Document Numbering for Sales Transactions

You can now automate generation of document numbers for invoices and related transactions for the sales made by your organization. These document numbers are based on the document class, third-party of the transaction, and transaction type. The resultant values are the branch number and the sequence, the combination of these values make up the document number to be stamped on the transaction.
To automate document numbering for your organizations, complete the following set up:

- **Localization system options:** Use the Manage Localization System Options task to update the country in which your business unit operates, use the **Country** field. Check the **Enable Document Numbering** check box.

- **Define document numbering:** Use the Manage Localization Document Numbering task and set the country. Select the business unit for which you want to define document numbering.

- **Specify the party fiscal classifications:** Select the **Configure Context Values** option on the Manage Localization Document Numbering page, an ADFDi spreadsheet appears. Specify the party fiscal classifications that will specify the document letter in document numbering sequence.

- **Select the document class, document letter, and the transaction type for which you want specify a document number.** Select the document sequence and authorization codes that need to be applied during a given period.

Document numbers are stamped on the transaction to indicate completion of an action.

### Import Outbound Fiscal Documents

Use the Import Fiscal Document Attributes Template to populate your Fiscal Document Attributes and upload them into Oracle Fusion Applications. Prepare the required Fiscal Document Attributes offline in the applicable spreadsheet templates. The template contains an instruction sheet to help guide you through the process of entering the required information.

You can import Fiscal Documents from other systems using the Import AutoInvoice with Fiscal Attributes process. Use the Import AutoInvoice with Fiscal Attributes process to import fiscal document Attributes that are related to Receivables transactions, therefore, outbound fiscal documents.

To access the template, complete the following steps:

1. Navigate to the File-Based Data Import for Oracle Financials Cloud guide.
2. In the Table of Contents, click **File-Based Data Imports**.
3. Click **Outbound Fiscal Document Import**.
4. In the File Links section, click the link to the Excel template.

Follow these guidelines when preparing your data in the worksheet:

- Enter the required information for each column. Refer to the tool tips on each column header for detailed instructions.
- Do not change the order of the columns in the template.
- You can hide or skip the columns you do not use, but do not delete them.

### Settings That Affect the Outbound Fiscal Document Attributes Import Process

The Import Fiscal Document Attributes template contains an instructions tab, plus four tabs that represent the table where the data is loaded:

<table>
<thead>
<tr>
<th>Spreadsheet Tab</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Instructions and CSV Generation</td>
<td>Contains instruction information about preparing and loading data, the format of the template, submitting the Import Outbound Fiscal Document Attributes process, and correcting import errors.</td>
</tr>
<tr>
<td>Fiscal Attribute Headers</td>
<td>Captures Fiscal Document Header data from which Fiscal Documents headers are created after successful import. Fiscal Document header is created and tied to a Receivables Transaction.</td>
</tr>
<tr>
<td>(JG_ FSCL_ HDRS_ ATRB_INT)</td>
<td></td>
</tr>
</tbody>
</table>
### Spreadsheet Tab Description

<table>
<thead>
<tr>
<th>Spreadsheet Tab</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fiscal Attribute Header Details</td>
<td>Captures the Fiscal Document Header Details data that you intend to assign to imported transactions. Data in this sheet is linked to the parent entity sheet Fiscal Attribute Headers using Document Id.</td>
</tr>
<tr>
<td>(JG_FSCL_HDR_DTLS_ATRB_INT)</td>
<td></td>
</tr>
<tr>
<td>Fiscal Attribute Lines</td>
<td>Captures Fiscal Document Lines information for imported transactions. Data in this sheet is linked to the parent entity sheet, Fiscal Attribute Headers, using Document Id.</td>
</tr>
<tr>
<td>(JG_FSCL_LINES_ATRB_INT)</td>
<td></td>
</tr>
<tr>
<td>Fiscal Attribute Line Details</td>
<td>Captures the Fiscal Document Line Details data that you intend to assign to imported transactions. Data in this sheet is linked to the parent entity sheet, Fiscal Attribute Lines, using Document Id and Transaction Line Number.</td>
</tr>
<tr>
<td>(JG_FSCL_LN_DTLS_ATRB_INT)</td>
<td></td>
</tr>
</tbody>
</table>

### How Outbound Fiscal Document Attributes Import Data Is Processed

#### Loading the Data

After you finish preparing the data, you must load the data. To load the data:

1. On the Instructions and CSV Generation tab of the template, click the **Generate CSV File** button to generate a Zip file containing one or more CSV files.
2. From Scheduled Process, use Load Interface File for Import and select **Import Process Import AutoInvoice with Fiscal Attributes** as the import process.
3. In Data File, select **Upload a new file** and then select the Zip file you created.

#### Importing the Loaded Data

After you successfully load your data, you must submit the AutoInvoice processes to import the data into the application tables and create the transactions.

- Use the Import AutoInvoice process to create the Receivables transactions
- Use the Import AutoInvoice with Fiscal Attributes process to create the Outbound Fiscal Document Attributes related to the Receivables transactions

For more information on the Receivables AutoInvoice Import process, refer to Oracle Enterprise Repository for Oracle Fusion Applications.

To submit the Import AutoInvoice with Fiscal Attributes process:

1. Navigate to the Scheduled Processes page.
2. Click **Schedule New Process** in the Search Results table.
3. Select the **Import AutoInvoice with Fiscal Attributes** process and click **OK**.
4. Enter the input parameters as needed:

<table>
<thead>
<tr>
<th>Input Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Batch Name</td>
<td>The batch name used in the Load File for Import Process</td>
</tr>
<tr>
<td>From Transaction Number / To Transaction Number</td>
<td>The range of transactions to be processed</td>
</tr>
<tr>
<td>From Date / To Date</td>
<td>The range of documents in between those dates to be processed</td>
</tr>
</tbody>
</table>
5. Submit the process.
7. If the Import Autolnvoice with Fiscal Attributes process ends in error or warning, review the log file for details about the rows that caused the failure.

To correct import errors:
1. Navigate to the Billing work area.
2. From the Fiscal Document Generation menu, go to Spreadsheet for Fiscal Attribute Corrections.
3. Review the Autolnvoice with Fiscal Attribute Errors table to view the errors.
4. Click the Number of Errors link to open the Manage Autolnvoice with Fiscal Attributes Lines spreadsheet to review and correct the errors in the imported data.
5. After all the incorrect rows are corrected, resubmit the import data for validation by clicking Submit Autolnvoice with Fiscal Attributes.
6. Repeat the submit and error correction steps in this section until all rows are imported successfully and the transactions are created.

Upload Receivables Bank Returns Data

On receiving collection instructions, the bank collects the amounts and returns information in an electronic format. Those details are imported into the application through this process. This process validates each record against the related collection documents, supplier, customer, and the related setup. For records that are invalid, the details appear in an ADFdi spreadsheet ‘Correct Bank Returns’ and it allows to make the required corrections and import the corrected records. After all the records in a bank return file are successfully validated, the Bank Return process can be initiated to generate return collection document updates and receipts, and if applicable, adjustments for interest and discounts. In cases where the calculated interest is different from the received interest, debit memos can be automatically generated or the differences be written off (depending on defined tolerance limits). Receipts are applied to the original installments that were selected in a collection document.

To access the template, complete the following steps:
1. Navigate to the File-Based Data Import for Oracle Financials Cloud guide.
2. In the Table of Contents, click File-Based Data Imports.
3. Click Receivables Bank Returns Data Upload Interface.
4. In the File Links section, click the link to the Excel template.

Follow these guidelines when preparing your data in the worksheet:

- Enter the required information for each column. Refer to the tool tips on each column header for detailed instructions.
- Do not change the order of the columns in the template.
- You can hide or skip the columns you do not use, but do not delete them.

Settings That Affect the Receivables Bank Returns Data Upload Interface

The template consists of two sheets:
- Instructions and CSV Generation
- Receivables Bank Returns

You can enter data in the Receivables Bank Returns sheet per the guidelines in the following table:
<table>
<thead>
<tr>
<th>Field Name</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>FILE_CONTROL</td>
<td>Bank Control File number received from Bank</td>
</tr>
<tr>
<td>ENTRY SEQUENTIAL NUMBER</td>
<td>Register sequence number on electronic file received from the bank.</td>
</tr>
<tr>
<td>REGISTER_TYPE</td>
<td>Identifier for header, detail and trailer records in electronic file received from the bank.</td>
</tr>
<tr>
<td>TRADE_NOTE_AMOUNT</td>
<td>Amount due remaining on collection document received from the bank.</td>
</tr>
<tr>
<td>FILE_GENERATION_NUMBER</td>
<td>Oracle internal use only.</td>
</tr>
<tr>
<td>COMPANY_CODE</td>
<td>Company code provided by the bank at the time of contract for services associated with the remittance and return of a collection document.</td>
</tr>
<tr>
<td>COMPANY_NAME</td>
<td>Company name of the first party associated with the company code provided by the bank.</td>
</tr>
<tr>
<td>GENERATION_DATE</td>
<td>Date on which the interface records were generated. Date Format: MM/DD/YYYY</td>
</tr>
<tr>
<td>REMITTANCE_CODE</td>
<td>Bank remittance code in electronic file from the original line sent by the company.</td>
</tr>
<tr>
<td>BANK_NUMBER</td>
<td>Unique numeric identifier for a bank.</td>
</tr>
<tr>
<td>BANK_OCCURRENCE_CODE</td>
<td>Occurrence code returned by the bank related to a bank occurrence.</td>
</tr>
<tr>
<td>OCCURRENCE_DATE</td>
<td>Correction date for a bank occurrence received from the bank. Date Format: MM/DD/YYYY</td>
</tr>
<tr>
<td>INSCRIPTION_NUMBER</td>
<td>Company registration number in electronic file received from the bank.</td>
</tr>
<tr>
<td>COMPANY_USE</td>
<td>Collection document unique identifier for matching purposes.</td>
</tr>
<tr>
<td>OUR_NUMBER</td>
<td>Collection document identifier generated by the bank or the company responsible for the collection document printing.</td>
</tr>
<tr>
<td>PORTFOLIO_CODE</td>
<td>Portfolio code in electronic file received from the bank.</td>
</tr>
<tr>
<td>YOUR_NUMBER</td>
<td>Collection document number related to the document given by the company.</td>
</tr>
<tr>
<td>DUE_DATE</td>
<td>Due date for a collection document received from the bank. Date Format: MM/DD/YYYY</td>
</tr>
<tr>
<td>COLLECTOR_BANK_NUMBER</td>
<td>Numeric identifier for collecting bank.</td>
</tr>
<tr>
<td>COLLECTOR_BRANCH_NUMBER</td>
<td>Numeric identifier for collecting bank branch.</td>
</tr>
<tr>
<td>TRADE_NOTE_TYPE</td>
<td>Oracle internal use only.</td>
</tr>
<tr>
<td>BANK_CHARGE_AMOUNT</td>
<td>No longer used.</td>
</tr>
</tbody>
</table>
How Receivables Bank Returns Data Upload Interface Is Processed

The Brazil Bank Return Files Import and Validation flow starts with users receiving Customer Payments Banks Processing Return files with the respective formats. You have to implement a custom process to execute a conversion to the Oracle Financials Cloud Import format and generate a .csv file following that format. That file must be transmitted to Oracle Cloud UCM. The Load and Import process, as well as the Validate process are then executed.

Load the Data into the Interface Tables

1. After you finish preparing the data in the parent and child sheets, click the Generate CSV File button. The process generates both a CSV file and a ZIP file.
2. Load the data using the Load Interface File for Import process:
   a. Sign in to the Oracle Public Cloud SFTP server.
   b. Transfer the ZIP file to the SFTP server location.
   c. Sign in to Oracle Fusion Applications.
   d. Navigate to Scheduled Processes.
   e. Select Load Interface File for Import.
   f. Select the process indicated in the Overview section to load the CSV file to the interface tables.
   g. Review the results of the process.
   h. If necessary, correct any errors in the CSV file and rerun the Load Interface File for Import process.
3. Correct load errors:
   a. If the load of the CSV file fails on any row, the Load Interface File for Import process ends in error and the Load File to Interface child process ends in either warning or error.
   b. All rows that were loaded from the CSV file are deleted including the ones that loaded successfully. This lets you edit the problematic data in the spreadsheet and resubmit without having to separate the successful rows from the rows that need modification.
   c. Review the log and output files of the Load File to Interface child process for information about the data that caused the failure.
   d. Correct the data in the template you used.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>ABATEMENT_ AMOUNT</td>
<td>Abatement amount for a bank collection document received from the bank.</td>
</tr>
<tr>
<td>DISCOUNT_ AMOUNT</td>
<td>Discount amount for a bank collection document received from the bank.</td>
</tr>
<tr>
<td>CREDIT_AMOUNT</td>
<td>Credit amount for a collection document received from the bank.</td>
</tr>
<tr>
<td>INTEREST_ AMOUNT_ RECEIVED</td>
<td>Paid interest amount for a collection document received from the bank.</td>
</tr>
<tr>
<td>CUSTOMER_NAME</td>
<td>Customer name on a collection document received from the bank.</td>
</tr>
<tr>
<td>RETURN_INFO</td>
<td>Return information comment on a bank occurrence on a collection document received from the bank.</td>
</tr>
</tbody>
</table>
e. Repeat steps 1 and 2 of this section: Generate the CSV file and load the data using the Load Interface File for Import process.

f. Repeat all of these steps until all data is loaded successfully.

Payables

How You Pay Enhancements for Brazil

Use Oracle Financials Cloud to manage your Payables transactions and comply with the local Brazilian business practices and government regulations. You can manage the collection documents received from the supplier and associate it with an invoice or payment schedule in order to pay invoices or installments. If any invoices are paid late, interest is calculated and added to the invoice amount according to the agreed terms between the seller and buyer and in compliance with the locally legislated business calendar.

You can:

- Enter a collection document manually or import an electronic collection document and associate it with one or more invoices or installments.
- Place holds on invoices or installments that are not associated with any collection document and automatically release holds after assignment.
- Calculate and pay interest for late payments based on predefined rules from suppliers. The interest is calculated based on rules that govern penalties, grace periods, and interest calculation methods. Use local business calendars to determine the number of days for interest calculation.

Use the following features to record a manual collection document or import an electronic collection document, and associate it with one or more installments:

- Create a Payables invoice.
- Associate collection documents with invoices.
- Calculate interest and pay through Payment Process Request.
- Manual Bank Return and Import Bank Return

Create Payables Invoice

Create a Payables invoice based on the information received from supplier. When creating an invoice, update the global descriptive flexfields. To update the global descriptive flexfields, click the Additional Information tab. You will have to select the **Invoices for Brazil** option for the **Regional Information** field. Select **Yes** for the **Enable Collection Document Processing** field.

After an invoice is created, an installment is generated for the invoice with due dates and payment amounts. It also includes the information updated in the global descriptive flexfields for the collection document.

When an invoice is validated, the installment is placed on hold until it is associated with a collection document.

For interest calculation, update the relevant information for payment schedules. To update the relevant information, click the **Manage Installments from Invoice Actions** list and then click the **Details** button. Select **Payment Installment Information for Brazil** from the **Regional Information** list. Provide the interest calculation details and save it.
Associate Collection Documents with Invoices or Installments

Once the collection document is entered into the application either manually or imported, the next step is to associate it with the installments. The collection document includes information such as barcode number, supplier name, supplier site, gross amount, due date, the details of bank where payment is to be made, document details, discount details, and so on. This association can be automatic or manual.

There are predefined setups and tolerance limits for automatic association, based on these setups and tolerances automatic association is done by the application. If the application cannot perform automatic association, then manual association is to be done by the user at a later stage. You can dissociate an installment from a collection document, if you think the current installment can’t go with the current collection document.

Once the association of the installment is complete, the hold applied on the invoice is removed automatically.

Calculate Interest and Make Payments

When invoices are paid after the due date, interest and penalties are charged on the invoices according to the agreed terms between the buyer and the seller. The interest can be simple interest or compound interest and penalty can be amount or percentage. You can define some grace days based on the type of interest that is charged.

Define a business day calendar and local holidays for the city based on which the due date is determined. Interest is calculated on the overdue invoices based on the due date.

Based on settings, interest can be calculated for late payments on invoices taking into consideration the number of grace days that are defined and whether the payment due date falls on a non-business day.

For the interest calculated, a new interest invoice is automatically created and the same is included in the next batch for payment.

To ensure the correct interest is collected, a local business day calendar with the correct local holidays for the city of the supplier must be defined. Interest is calculated on the overdue invoices based on the due date and taking into consideration the number of grace days that are defined and whether the payment due date falls on a non-business day.

Process Bank Returns

The bank sends an electronic fund transfer file that gives the status of the payments made against invoices for the submitted collection documents. The electronic fund transfer file provides information on whether the payment was successful or rejected.

When a payment is rejected, the reasons for rejection are recorded against each invoice. Codes and reasons for rejection are maintained in the application.

Once the EFT file is imported into the application, the application associates the rejected invoice with the relevant reason for return. This enables further action like making a payment for the same in future.

Upload Payables Bank Returns Data

Bank return import file contains details sent by the bank on the status of payment requests that have been sent to the bank for payment. It contains details of each payment using the reference of the Return Identifier, which uniquely identifies a specific payment request made to the bank. Different banks use different bank return codes. On importing the details, the status of the collection documents that are matched with the invoice installments get updated based on the corresponding return codes.
To access the template, complete the following steps:

1. Navigate to the File-Based Data Import for Oracle Financials Cloud guide.
2. In the Table of Contents, click **File-Based Data Imports**.
3. Click **Payables Bank Returns Data Upload Interface**.
4. In the File Links section, click the link to the Excel template.

Follow these guidelines when preparing your data in the worksheet:

- Enter the required information for each column. Refer to the tool tips on each column header for detailed instructions.
- Do not change the order of the columns in the template.
- You can hide or skip the columns you do not use, but do not delete them.

**Settings That Affect the Payables Bank Returns Data Upload Interface**

The template consists of two sheets:

- **Instructions and CSV Generation**
- **Bank Returns**

You can use the following table to populate the Bank Returns sheet:

<table>
<thead>
<tr>
<th>Name</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>BANK_RETURN_ID</td>
<td>Value generated during the processing of a payment request. It is passed to bank in a payment request file. It is also used to uniquely refer individual payment requests.</td>
</tr>
<tr>
<td>BANK_OCCURRENCE_CODE</td>
<td>Occurrence error details sent by the bank. It is also a foreign key to the JL_BR_AR_BANK_OCCURRENCES table.</td>
</tr>
<tr>
<td>OCCURRENCE_DATE</td>
<td>Occurrence error date sent by the bank.</td>
</tr>
<tr>
<td>PAYMENT_REQUEST_IDENTIFIER</td>
<td>ESS ID of the payment request.</td>
</tr>
</tbody>
</table>

**How Payables Bank Returns Data Upload Is Processed**

Brazil Bank Return Files Import and Validation flow starts with Users receiving Payer Banks Processing Return files with respective formats. Users have to implement a process to execute a conversion to Oracle Financials Cloud Import format and generate a .csv file following that format. That file should be transmitted to Oracle Cloud UCM. Load and Import process and Validate process should be executed.

**Load the Data into the Interface Tables**

1. After you finish preparing the data in the parent and child sheets, click the Generate CSV File button. The process generates both a CSV file and a ZIP file.
2. Load the data using the Load Interface File for Import process:
   a. Sign in to the Oracle Public Cloud SFTP server.
   b. Transfer the ZIP file to the SFTP server location.
   c. Sign in to Oracle Fusion Applications.
   d. Navigate to Scheduled Processes.
   e. Select **Load Interface File for Import**.
f. Select the process indicated in the Overview section to load the CSV file to the interface tables.

g. Review the results of the process.

h. If necessary, correct any errors in the CSV file and rerun the Load Interface File for Import process.

3. Correct load errors:

a. If the load of the CSV file fails on any row, the Load Interface File for Import process ends in error and the
   Load File to Interface child process ends in either warning or error.

b. All rows that were loaded from the CSV file are deleted including the ones that loaded successfully. This lets
   you edit the problematic data in the spreadsheet and resubmit without having to separate the successful rows
   from the rows that need modification.

c. Review the log and output files of the Load File to Interface child process for information about the data that
   caused the failure.

d. Correct the data in the template you used.

e. Repeat steps 1 and 2 of this section: Generate the CSV file and load the data using the Load Interface File for
   Import process.

f. Repeat all of these steps until all data is loaded successfully.

Upload Payables Collection Documents Data

The process starts once the supplier sends a collection document against which payment has to be made. This collection
document may include an invoice installment or a group of installments from various invoices. This process is used to import
collection documents from the bank, as initiated by the supplier. If the import validation errors option is set to NO, then the
collection lines are auto-matched with the transaction installments. If it is set as YES, then based on the action set, either the
master or the reference data is changed, or the import lines are rejected and the bank is informed.

To access the template, complete the following steps:

1. Navigate to the File-Based Data Import for Oracle Financials Cloud guide.
2. In the Table of Contents, click File-Based Data Imports.
3. Click Payables Collection Documents Data Upload Interface.
4. In the File Links section, click the link to the Excel template.

Follow these guidelines when preparing your data in the worksheet:

- Enter the required information for each column. Refer to the tool tips on each column header for detailed
instructions.
- Do not change the order of the columns in the template.
- You can hide or skip the columns you do not use, but do not delete them.

Settings That Affect Payables Collection Documents Data Upload Interface

The template consists of two sheets:

- Instructions and CSV Generation
- Payables Collection Documents

You can enter data in the Payables Collection Documents sheet per the guidelines in the following table:

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>FILE_CONTROL</td>
<td>Bank control file name received from the bank.</td>
</tr>
<tr>
<td>Field Name</td>
<td>Comments</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>----------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>ENTRYSEQUENTIALNUMBER</td>
<td>Entry sequential number on an imported bank collection document.</td>
</tr>
<tr>
<td>DOCUMENTNUMBER</td>
<td>Collection Document number on an imported bank collection document.</td>
</tr>
<tr>
<td>DOCUMENTDATE</td>
<td>Date on an imported bank collection document.</td>
</tr>
<tr>
<td>CNABCODE</td>
<td>No longer used.</td>
</tr>
<tr>
<td>DUEDATE</td>
<td>Due date on an imported bank collection document.</td>
</tr>
<tr>
<td>AMOUNT</td>
<td>Total amount of associated installments on an imported bank collection document.</td>
</tr>
<tr>
<td>ARREARSDATE</td>
<td>Use the same date as in DOCUMENTDATE.</td>
</tr>
<tr>
<td>ARREARSCODE</td>
<td>Use 1.</td>
</tr>
<tr>
<td>ARREARSINTEREST</td>
<td>Use 1.</td>
</tr>
<tr>
<td>DRAWEENAME</td>
<td>Registered Payer name on an imported bank collection document.</td>
</tr>
<tr>
<td>DRAWEEBANKCODE</td>
<td>Payer bank code on an imported bank collection document.</td>
</tr>
<tr>
<td>DRAWEEBANKNAME</td>
<td>Payer bank name on an imported bank collection document.</td>
</tr>
<tr>
<td>DRAWEEBRANCHCODE</td>
<td>Payer bank branch code on an imported bank collection document.</td>
</tr>
<tr>
<td>DRAWEEACCOUNTNUMBER</td>
<td>Payer account number on an imported bank collection document.</td>
</tr>
<tr>
<td>DRAWEEINSCRIPTIONTYPE</td>
<td>Payer inscription type on an imported bank collection document.</td>
</tr>
<tr>
<td>DRAWEEINSCRIPTIONNUMBER</td>
<td>Payer Taxpayer Id on an imported bank collection document.</td>
</tr>
<tr>
<td>TRANSFERORNAMEME</td>
<td>The Supplier name of a bank collection document.</td>
</tr>
<tr>
<td>TRANSFERORBANKCODE</td>
<td>Bank code of the supplier on an imported bank collection document.</td>
</tr>
<tr>
<td>TRANSFERORBRANCHCODE</td>
<td>Branch code of the supplier on an imported bank collection document.</td>
</tr>
<tr>
<td>TRANSFERORACCOUNTNUMBER</td>
<td>Account number of the supplier on an imported bank collection document.</td>
</tr>
<tr>
<td>TRANSFERORINSCRIPTIONTYPE</td>
<td>Inscription type of the supplier site on an imported bank collection document.</td>
</tr>
<tr>
<td>TRANSFERORINSCRIPTIONNUMBER</td>
<td>Taxpayer ID of the supplier site on an imported bank collection document.</td>
</tr>
</tbody>
</table>
Field Name | Comments
--- | ---
ACCOUNTING_BALANCING_SEGMENT | No longer used.
SET_OF_BOOKS_ID | No longer used.
ORG_ID | Indicates the identifier of the business unit associated to the row.
BARCODE_TYPE_CODE | Type of barcode used for a Brazilian Payables collection document.
BARCODE | The numeric representation of barcode number (manual) or the barcode number (scanned).
ELECTRONIC_FORMAT_FLAG | Electronic bank collection indicator.

How Payables Collection Documents Data Upload Interface Is Processed

Load the Data into the Interface Tables

1. After you finish preparing the data in the parent and child sheets, click the Generate CSV File button. The process generates both a CSV file and a ZIP file.
2. Load the data using the Load Interface File for Import process:
   a. Sign in to the Oracle Public Cloud SFTP server.
   b. Transfer the ZIP file to the SFTP server location.
   c. Sign in to Oracle Fusion Applications.
   d. Navigate to Scheduled Processes.
   e. Select **Load Interface File for Import**.
   f. Select the process indicated in the Overview section to load the CSV file to the interface tables.
   g. Review the results of the process.
   h. If necessary, correct any errors in the CSV file and rerun the Load Interface File for Import process.
3. Correct load errors:
   a. If the load of the CSV file fails on any row, the Load Interface File for Import process ends in error and the Load File to Interface child process ends in either warning or error.
   b. All rows that were loaded from the CSV file are deleted including the ones that loaded successfully. This lets you edit the problematic data in the spreadsheet and resubmit without having to separate the successful rows from the rows that need modification.
   c. Review the log and output files of the Load File to Interface child process for information about the data that caused the failure.
   d. Correct the data in the template you used.
   e. Repeat steps 1 and 2 of this section: Generate the CSV file and load the data using the Load Interface File for Import process.
   f. Repeat all of these steps until all data is loaded successfully.
3 How To Topics

Overview of Configuring Fiscal Document for Brazil

You can now create and manage fiscal documents for Brazil by using the fiscal document generation feature in Oracle ERP Cloud. In Brazil, fiscal documents are required to comply with the regulations of the tax authorities. They also register a transfer of ownership of goods or commercial activity by a company to an individual or to another company.

You can use the fiscal document generation feature to create and manage fiscal documents for the following:

- Sales invoices
- Internal transfer shipments
- Shipments of returns to vendors
- Internal transfer of fixed assets

As the fiscal document generation process is integrated with Receivables, you can perform the following tasks before invoices are completed:

- Enter the appropriate fiscal attributes
- Calculate taxes
- Generate a fiscal document for sales invoices

Since this feature is also integrated with Shipping, you can perform the following actions:

- Capture the fiscal attributes
- Generate and manage the fiscal documents before the internal transfers and RTV shipments are released

For fixed asset transfers, the required transaction information is moved to Receivables, so that a fiscal document can be generated based on a non-receivable invoice.

For detailed information on configuring fiscal documents for Brazil, see related topics.

Related Topics
- Configuring Fiscal Documents for Brazil

Overview of Configuring Tax Registrations for Brazil

You can use Oracle ERP Cloud to capture, maintain, and validate company registration numbers, such as the National Register of Legal Entities (CNPJ), Individual Taxpayer Registry (CPF), State Inscription Number (IE), Municipal Inscription Number (IM), and Superintendence of the Manaus Free Zone (SUFRAMA) in Brazil, for enterprise, suppliers, customers, and other parties. These registration numbers are required by the tax authorities, and defined as tax registrations and taxpayer IDs. As part of the fiscal document information, they are displayed in the Manage Fiscal Document Generation page, and extracted for submission to the tax authorities.

For more information on configuring tax registrations for Brazil, see related topics.
Overview of Managing Fiscal Documents Approvals Through a Third Party

You can now use the Fiscal Document Generation feature in Oracle ERP Cloud to obtain fiscal document approval from a tax authority through a third party.

The third party can be any fiscal partner responsible for formatting the fiscal document XML file, communicating with the tax authority, and sending the response back to Fiscal Document Generation. The following diagram summarizes the main processes:

For more information on fiscal document approval through a third party, see related topics.

Related Topics

- Managing Fiscal Documents Approvals through a Third Party
Overview of Managing General Fiscal Documents

Fiscal documents are required in Brazil to comply with the regulations of the Brazilian tax authorities. They also help to register a transfer of ownership of a good or a commercial activity provided by a company to an individual or to another company.

You can use the fiscal document generation feature to create and manage fiscal documents for sales invoices, internal transfer shipments, returns to supplier shipments, and internal transfer of fixed assets.

For more information on managing general fiscal documents, see related topics.

Related Topics
- Managing General Fiscal Documents

Overview of Managing Fiscal Documents for Manual Receivables Invoices

You can generate fiscal documents based on manually created Receivables transactions. You can perform the following tasks:

- Create goods invoices to generate fiscal documents for sales of goods approved by SEFAZ, the tax authority in Brazil.
- Create service invoices to generate fiscal documents for sales of services approved by City Tax Authority.
- Create mixed invoices to generate fiscal documents for sales of services and sales of goods approved by both the tax authorities.

During transaction entry, the following fiscal document information is required:

- Bill to and ship to parties
- Bill to and ship to locations
- Taxes
- Products
- Quantities
- Amounts

For more information on fiscal document for a manual receivables invoice, see related topics.

Related Topics
- Managing Fiscal Documents for Manual Receivables Invoices
Overview of Managing Fiscal Documents for Imported Receivables Invoices

Oracle ERP Cloud now enables you to import fiscal attributes to generate fiscal documents based on imported Receivables transactions.

To create transactions in Receivables using AutoInvoice, you can import the transaction data from: and , and from , to create transactions in Receivables using AutoInvoice.

- Oracle Cloud Projects
- Oracle Cloud Distributed Order Orchestration
- non-Oracle financial systems

You can also create and transfer order lines from Oracle CPQ Cloud to AutoInvoice using the Receivables Invoice Service.

For more information on managing fiscal documents based on imported Receivables transactions, see related topics.

Related Topics
- Managing Fiscal Documents for Imported Receivables Invoices

Overview of Managing Fiscal Document Variations

The Fiscal Document Generation feature, in addition to the regular approval flow, enables you to:

- Cancel the fiscal document when it is approved by the tax authority, but the goods or services are no longer intended to be shipped or provided.
- Void a fiscal document if you want to report to Tax Authority that the fiscal document number will not be used.
- Generate the fiscal document in contingency mode so that the goods can be shipped even when there are communication issues with tax authority.
- Review taxes returned by city tax authority when they are different from the calculated taxes.

The Fiscal Document Generation tasks to handle these flows are the same, whether the fiscal document is generated in Inventory Management or Receivables.

For more information on fiscal document processing variations, see related topics.

Related Topics
- Managing Fiscal Document Variations
Overview of Managing Transaction Taxes for Brazil

Now you can manage transaction taxes for Brazil in Oracle ERP Cloud.

You can manage the following tax regimes:

- **ICMS**: Tax on the Circulation of Merchandise and Interstate and Inter Municipal Transportation Services and Communications
- **IPI**: Industrialized Products Tax
- **PIS and COFINS**: Contribution to the Social Integration Program and Civil Service Asset Formation Program and Contribution to Social Security Financing
- **ISS**: City Tax on Services Billing

For detailed information on managing transaction taxes for Brazil, see related topics.

Related Topics

- Managing Transaction Taxes for Brazil

Overview of Managing Withholding Taxes for Brazil

Now you can manage withholding taxes for Brazil in Oracle ERP Cloud.

Some of the typical withholding taxes that you can manage in Oracle ERP Cloud are:

- **IRR_F_PF**: Federal withholding tax that is applicable for services provided by persons
- **IRR_F_PJ**: Federal withholding tax that is applicable for services provided by companies
- **INSS_F_PF**: Social security withholding tax that is applicable for services provided by persons
- **INSS_F_PJ**: Social security withholding tax that is applicable for services provided by companies
- **PIS/COFINS/CSLL**: Federal contribution withholding tax that is applicable for services provided by companies
- **ISS**: City (municipal) withholding tax that is applicable for services provided by companies and persons

For detailed information on managing withholding taxes for Brazil in Oracle ERP Cloud, see related topics.

Related Topics

- Managing Withholding Taxes for Brazil
Overview of Managing Fiscal Documents for Internal Material Transfers

You can now generate a fiscal document for an internal material transfer shipment independent of its source. You can create internal material transfer requests from various sources such as Back-to-Back Supply for Sales Orders, Self Service Procurement, Manage Item Quantities from Inventory Management, and so on.

For detailed information on managing fiscal documents for internal material transfers in Oracle ERP Cloud, see related topics.

Related Topics
- Managing Fiscal Documents for Internal Material Transfers

Overview of Managing Fiscal Documents for Returns to Supplier

You can now generate fiscal documents for returns to supplier shipments in Oracle ERP Cloud. To return items to the supplier, you must generate a return fiscal document for transporting the returned items back to the supplier. Returns are needed when a customer rejects an item from their received shipment, a defect is found internally, and so on.

For detailed information on managing fiscal documents for returns to supplier in Oracle ERP Cloud, see related topics.

Related Topics
- Managing Fiscal Documents for Returns to Supplier

Overview of Creating Fiscal Documents for Fixed Asset Transfers

You can now generate fiscal documents for fixed asset transfers in Oracle ERP Cloud. If you physically move an asset from one location to another, and if the new location belongs to a different reporting unit within an organization, you must generate a fiscal document for the asset transfer.

For detailed information on creating fiscal documents for fixed asset transfers in Oracle ERP Cloud, see related topics.

Related Topics
- Creating Fiscal Documents for Fixed Asset Transfers
Overview of Managing Fiscal Documents for Miscellaneous Purposes

You can now use the fiscal document generation feature in Oracle ERP Cloud to create inbound and outbound fiscal documents for multiple purposes.

For example, you can use this approach to create fiscal documents for a return from customer, a goods shipment for exportation, a demonstration, a repair, a loan, and so on.

For detailed information on creating managing fiscal documents for miscellaneous purposes in Oracle ERP Cloud, see related topics.

Related Topics
- Managing Fiscal Documents for Miscellaneous Purposes

Overview of Managing Complementary Fiscal Documents for Brazil

Oracle ERP Cloud now enables you to handle tax during the capture of complementary fiscal documents.

For standard business flows, suppliers may want to rectify mistakes made in earlier fiscal documents. They must issue a complementary fiscal document when there is a change in quantity, price, or taxes. The three types of complementary fiscal documents are:

- Tax Correction
- Price Correction
- Quantity Correction

For detailed information on capturing complementary fiscal documents, see related topics.

Related Topics
- Managing Complementary Fiscal Documents for Brazil

Overview of Capturing Fiscal Documents of Purchase Orders

You can now manage taxes and additional fiscal attributes during the capture of fiscal documents associated with purchase orders in Oracle ERP Cloud.

You can use the fiscal document capture feature to perform the following actions:

- Enter the fiscal document manually.
• Capture the fiscal document XML file received directly from the supplier.

For detailed information on capturing fiscal documents for purchase orders, see related topics.

Related Topics
• Capturing Fiscal Documents of Purchase Orders

Overview of Entering Fiscal Documents in Payables

If you have not implemented the Fiscal Document Capture feature, you can record a service fiscal document directly through a Payables invoice by calculating taxes and capturing the fiscal attribute details. You can manually enter or import invoices and their fiscal attributes from other systems. Fiscal Document Capture is the preferred method for entering a fiscal document. You can only enter fiscal documents in Payables if they meet all of the following criteria:

• Service fiscal document
• Fiscal document without recoverable taxes, such as ICMS, PIS, COFINS, and so on
• Fiscal document without services or charges associated with a manufacturing process, as the production cost is not updated
• Fiscal document for which all lines are payable

For detailed information on entering fiscal documents in payables, see related topics.

Related Topics
• Entering Fiscal Documents in Payables

Overview of Managing Payables Collection Documents for Brazil

The Payables process completes with the payment of invoice installments. In Brazil, a collection document is received from a supplier or supplier bank, in either a manual or electronic format, and is associated with invoice installments, either manually or automatically.

You can make payments through various methods such as check, Bordo (Payment authorization), and electronic file transfer (EFT). EFT is used for the bank collection process. The interest and penalties are calculated for overdue invoices according to the legislation and agreed terms between the seller and buyer. You can configure these terms in the application, per business unit, supplier or even supplier sites.

For detailed information on managing payables collection documents for Brazil, see related topics.

Related Topics
• Managing Payables Collection Documents for Brazil
4 Financials Reports for the Americas

Purchase Withholding Certificate for Chile

This topic contains summary information about the Purchase Withholding Certificate Report for Chile.

Overview
The Purchase Withholding Certificate Report for Chile helps with an in-depth analysis of all the information for transactions in the ledger currency that have transaction year within the certificate that is selected. The report displays the calendar periods, taxable service fee, as well as the payments on which amounts were withheld.

Key Insights
To generate the report, the role must be LAD Financial Reporting role, and it can be assigned to any job role. This do not need any job role exclusively.

Frequently Asked Questions
The following table lists frequently asked questions about the Purchase Withholding Certificate for Chile.

<table>
<thead>
<tr>
<th>FAQs</th>
<th>Answer</th>
</tr>
</thead>
<tbody>
<tr>
<td>How do I find this report?</td>
<td>In Oracle Business Intelligence Enterprise Edition, select Analysis from Analysis and Interactive Reporting.</td>
</tr>
<tr>
<td>Who uses this report?</td>
<td>• Financial Accountants</td>
</tr>
<tr>
<td></td>
<td>• Financial Specialists</td>
</tr>
<tr>
<td>When do I use this report?</td>
<td>Use the Purchase Withholding Certificate for Chile when you need to provide detailed records of your accounts to the fiscal authorities.</td>
</tr>
<tr>
<td>What type of report is this?</td>
<td>Oracle Transaction Business Intelligence</td>
</tr>
</tbody>
</table>

Purchase Withholding Certificate for Argentina

This topic contains summary information about the Purchase Withholding Certificate for Argentina.

Overview
The Purchase Withholding Certificate for Argentina provides all the report information for transactions in the ledger currency that have the transaction date within the date range that is selected.
Key Insights
To generate the report, the role must be LAD Financial Reporting role, and it can be assigned to any job role. This do not need any job role exclusively.

Frequently Asked Questions
The following table lists frequently asked questions about the Purchase Withholding Certificate for Argentina.

<table>
<thead>
<tr>
<th>FAQs</th>
<th>Answer</th>
</tr>
</thead>
<tbody>
<tr>
<td>How do I find this report?</td>
<td>In Oracle Business Intelligence Enterprise Edition, select Analysis from Analysis and Interactive Reporting.</td>
</tr>
<tr>
<td>Who uses this report?</td>
<td>• Financial Accountants&lt;br&gt;• Financial Specialists</td>
</tr>
<tr>
<td>When do I use this report?</td>
<td>Use the Purchase Withholding Certificate for Argentina when you need to extract information which electronically reports withholding VAT information.</td>
</tr>
<tr>
<td>What type of report is this?</td>
<td>Oracle Transaction Business Intelligence</td>
</tr>
</tbody>
</table>

Purchase Withholding Certificate for Colombia
This topic contains summary information about the Purchase Withholding Certificate for Colombia.

Overview
The Purchase Withholding Certificate for Colombia helps with an in-depth analysis of all the report information for the transactions in the ledger currency that have the transaction date within the date range that is selected.

Key Insights
To generate the report, the role must be LAD Financial Reporting role, and it can be assigned to any job role. This do not need any job role exclusively.

Frequently Asked Questions
The following table lists frequently asked questions about the Purchase Withholding Certificate for Colombia.

<table>
<thead>
<tr>
<th>FAQs</th>
<th>Answer</th>
</tr>
</thead>
<tbody>
<tr>
<td>How do I find this report?</td>
<td>In Oracle Business Intelligence Enterprise Edition, select Analysis from Analysis and Interactive Reporting.</td>
</tr>
</tbody>
</table>
### FAQs

<table>
<thead>
<tr>
<th>FAQs</th>
<th>Answer</th>
</tr>
</thead>
</table>
| Who uses this report?       | • Financial Accountants  
• Financial Specialists  |
| When do I use this report? | Use the Purchase Withholding Certificate for Colombia when you need to extracts information which electronically reports withholding VAT information for Colombia. |
| What type of report is this?| Oracle Transaction Business Intelligence    |